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1. Before starting the demonstration 

1-1. User Demonstration Kit 
 
The Keysight B1500A demonstration unit is delivered with the Keysight B1500A User Demonstration Kit. 
 
The user demonstration kit includes: 

1. User Demonstration Manual 
2. User Demonstration CD ROM 

The CD includes: 
- Demo measurement data 
- Demo measurement setup 
- Demo Library: Test definition 
- B1500A Functionality Tutorial video 

3. User Demonstration Device Kit 
- Initially it includes 10 MOS FETs 
 
Note:  
If you damage the demonstration device while in User Demonstration, 
please discard it and do not place the damaged device back to the 
Demonstration Device Kit. 
 

 
 
Note: 

The number of devices included in the User Demonstration Kit might be  
less than 10 if a device is damaged during the user demonstration. 
 
If no measurable device is included in the User Demonstration Kit,  
please contact your Keysight field engineer. 
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1-2. Requirements for Demo Equipment 
 
The Keysight B1500A user Demonstration Kit requires the following demo equipment. 
Please check that your demo equipment satisfies the minimum requirements for the User Demonstration.  
 
 Keysight B1500A Semiconductor Device 

Analyzer 
 SMUs x 4 ( as minimum)  
 Triaxial cables x 4 ( as minimum) 

 
Optional:  
The following measurement equipment is supported 
in the User Demonstration.  
 B1520A MFCMU x 1 
 N1301A opt 100 SCUU x 1 
 N1301A opt 102 SCUU cable x 1 
 E5288A ASU 
 B1514A MCSMU 

 
If your B1500A demo equipment comes with these optional items, you can 
experience IV and CV measurement without changing the cable connection. 

 
 Test Fixture (one from the following list) 

 Keysight N1295A Test Fixture 
 
 
 
 
 
 
 
 
 
 Keysight 16422B Test fixture 

 28 pin dual in-line socket x 1 
 Mini banana - Pin connecting wire x 4 

(as minimum) 
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 Accessories 
Here, the pictures of the typical accessory included in the Demo B1500A are introduced so as you can 
find out the necessary demo items when you configure the demonstration setup. 
 

 

 
  

 

16494A Triax Cable N1300A-002  CMU Cable

16493J Interlock Cable

16493L GNDU Cable

16493P SPGU Cable

Power CableKey Board Mouse

N1301A-100  SCUU

RSU and WGFMU/RSU Cable

N1301A-200  GSWU and 
Cables
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1-3. B1500A Demo Setup 
This section describes hardware setups of B1500A for user demonstration.  

Demo Setup of Keysight B1500A and Fixtures

B1500A and N1295A Test Fixture 16442B Test Fixture
(optional)

 

The picture shows the setup of the Keysight B1500A User Demonstration. 

B1500A Semiconductor Device Analyzer and N1295A Test Fixture are shown in left picture. 

16442B Test Fixture shown in right side is an optional setup of B1500A demonstration equipment. 

The Demo test device is set to the 28 PIN Dual In-Line Package Socket that is set to the 16442B. 
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Combination of B1500A Demo Configuration
Test Fixture & Test device Forming

N1295A 16442B (optional)

Standard
configuration

Optional
configuration 2

Optional
configuration 3

Optional
configuration 1

Demo B1500A Configuration: 
There are four combinations of B1500A demonstration setup. 
This page shows the overview of the combinations by using illustrations to help understanding the B1500A 
demo setups in the following few pages. 

There are two options in the test fixture and relating test device leads forming, 
and two options in B1500A`s setup, with and w/o SCUU. 

Those options are dependent on the B1500A demo configuration delivered to you, and you may not have 
an option to select a specific configuration. 
For B1500A side options, we recommend to fit the SCUU if it comes to your B1500A demo system, but w/o 
SCUU combination can be considered as an alternative selection if you would like to use the MFCMU 
independently as a standalone measurement unit. 
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Configuration Steps: 

Following few pages illustrate how to configure the test fixture to the B1500A for each configuration 
option. 
Please find out a proper configuration option of your demo B1500A from the above combination, and then, 
follow the instruction step number of the corresponding configuration page. 
 
Step 1: Setup of the SCUU 
      Applicable: 
 - Standard configuration 
 - Optional configuration 2 
Step 2: Cabling between the B1500A and the test fixture 
      Applicable: 
 - All the configuration.  Proceed to the applicable configuration page. 
Step 3: Wiring inside the 16442B Test Fixture 
      Applicable: 
 - 16442B Test Fixture (Optional configuration 3 and 4) 
                       Note: There is no wiring for N1295A Test Fixture 
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SCUU setup to B1500A

N1301A-100  SCUU

B1520A MFCMU

1
2

3

2

3

4 4

4
4

Follow the next steps to install the SCUU:

1. Mate the SMU`s triax connector to 
position the low side of the SCUU.

2. Mate and insert the control connector 
to the intermediate position by 
searching the fitting point of the 
connector of the MFCMU before 
inserting the CMU coaxial connectors.

3. Insert CMU`s coaxial connectors.

4. Push and screw on the SCUU to 
B1500A after making sure all the 
connecters mate in proper manner 
(smooth). 

Note:
GSWU is not used this time.

B1500A Demo Setup: Step 1 

 

Step 1: 
First step of the demonstration B1500A setup is to set the N1301A-100 SMU CMU Unify Unit (SCUU) to the 
B1500A. 
 
Attach the SCUU to the B1500A rear panel connectors for the MFCMU in the 
slot N and two SMUs in the slots N-1 and N-2 (N: integer, 3 to 10). 
Connection will be easy by bringing the control connectors together before 
bringing the BNC connectors. 

Follow the instruction shown in the above figure. 
1. Mate the SMU`s triax connector to position the low side of the SCUU. 
2. Mate and insert the control connector to the intermediate position by searching the fitting point 

of the connector of the MFCMU before inserting the CMU coaxial connectors. 
3. Insert CMU`s coaxial connectors. 
4. Push and screw on the SCUU to B1500A after making sure all the connecters mate in proper 

manner (smooth).  
Note: 

The installed slot number of B1520A MFCMU and SMUs (HRSMU or MPSMU) may differ from the 
figure shown above depending on your B1500A`s configuration.  
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1. Make connection between the 
Keysight B1500A and 
the N1295A Test Fixture using 
the triaxial cables 

B1500A Demo Setup with N1295A Test Fixture: Step 2 
- Standard Configuration (Cable Connection with SCUU)

Keysight N1295A Test Fixture

2: to SMU 2 

4: to SMU 3

3: to SMU 4

SMU 3

SMU 2

SMU 1

Keysight B1500A SMU & SCUU

Triaxial cable

SMU 4CH

CL
Triaxial cable

Note: 
The actual SMU configuration delivered to you may 
differ from the figure.  Always connect SCUU's Output 1 
(upper output Force 1 triaxial connector) to the SMU4 
of the 16442B and Output 2 to SMU3 INPUT.

SCUU
OUTPUT 1

OUTPUT 2

GNDU

1: to SMU1

1

2

3

4

 

Step 2: Standard Configuration 

B1500A configured with SMUs, MFCMU and SCUU with N1295A Test Fixture: 

This page shows the cable connection in the case of the B1500A configured with SMUs, MFCMU and SCUU. 

Module connection: 

The connection for with SCUU requires a little attention for cabling. 
1. Connect SMU 1 to the N1295A Input 1. 
2. Connect SMU 2 to the N1295A Input 2. 
3. Connect OUTPUT 2 (lower force triaxial connector) of the SCUU to the N1295A Input 4. 
4. Connect OUTPUT 1 (upper force triaxial connector) of the SCUU to the N1295A Input 3. 
Note 1:  
The connection between SCUU and the Test Fixture is twisted for #3 and #4 terminals to connect CH to 
gate pin #3 of Demo MOSFET. 
Note 2:  
OUTPUT 1 terminal of SCUU outputs CH or upper SMU (SMU 4 in this example), and OUTPUT 2 terminal of 
SCUU outputs CL or lower SMU (SMU3 in the example). 
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B1500A Demo Setup with N1295A Test Fixture : Step 2
- Optional Configuration 1 (Cable Connection without SCUU)

1. Make connection between the 
Keysight B1500A and 
the N1295A Test Fixture using the 
triaxial cables.

SMU 4

SMU 3

SMU 2

SMU 1

Triaxial cable

Note: 
The actual SMU configuration delivered to you may 
differ from the figure.  In that case, connect the triaxial 
cables in order to the B1500A SMU and the 16442B test 
fixture.

GNDU

Keysight B1500A SMU

Keysight N1295A Test Fixture

2: to SMU 2 

4: to SMU 3

3: to SMU 4

1: to SMU1

1
2
3

4

 

Step 2: Optional Configuration 1 
B1500A configured with SMUs and MFCMU with N1295A Test Fixture: 

B1500A configured with SMUs only: 

This page shows the cable connection in the case of the B1500A configuration without SCUU. 

SMU connection: 

Connect the Force terminal of the SMU and the N1295A input terminal as shown in the figure. 
1. Connect SMU 1 to the N1295A Input 1. 
2. Connect SMU 2 to the N1295A Input 2. 
3. Connect SMU 3 to the N1295A Input 4. 
4. Connect SMU 4 to the N1295A Input 3. 
 
Note: 
Make sure the SMU 3 and 4 cable to the test fixture is exchanged to the fixture input 4 and 3. 
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1. Make connection between the 
Keysight B1500A and 
the 16442B Test Fixture using 
the triaxial cables 

B1500A Demo Setup with 16442B Test Fixture: Step 2
- Optional Configuration 2 (Cable Connection with SCUU)

Keysight 16442B Test Fixture
SMU 1   SMU 2 

SMU3

SMU 3

SMU 2

SMU 1

Keysight B1500A SMU & SCUU

Triaxial cable

SMU 4CH

CL
Triaxial cable

Note: 
The actual SMU configuration delivered to you may 
differ from the figure.  Always connect SCUU's Output 1 
(upper output Force 1 triaxial connector) to the SMU4 
of the 16442B and Output 2 to SMU3 INPUT.

TO SMU 4

TO SMU 3

SCUU
OUTPUT 1

OUTPUT 2

GNDU1

2

3

4

SMU 4
to

SMU 3
module

 

 

Step 2: Optional Configuration 2 

B1500A configured with SMUs, MFCMU and SCUU with 16442B Test Fixture: 

This page shows the B1500A the cable connection in the case of the B1500A configured with SMUs, MFCMU 
and SCUU. 

Module connection: 

The connection for with SCUU requires a little attention for cabling. 
1. Connect SMU 1 to the SMU 1 terminal of the 16442B. 
2. Connect SMU 2 to the SMU 2 terminal of the 16442B. 
3. Connect OUTPUT 2 (lower force triaxial connector) of the SCUU to the SMU 4 terminal of the 16442B. 
4. Connect OUTPUT 1 (upper force triaxial connector) of the SCUU to the SMU 3 terminal of the 16442B. 
Note 1:  
The connection between SCUU and the Test Fixture is twisted for #3 and #4 terminals to connect CH to 
gate pin #3 of Demo MOSFET. 
Note 2:  
OUTPUT 1 terminal of SCUU outputs CH or upper SMU (SMU 4 in this example), and OUTPUT 2 terminal of 
SCUU outputs CL or lower SMU (SMU3 in the example). 
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B1500A Demo Setup with 16442B Test Fixture : Step 2
- Optional Configuration 3  (Cable Connection without SCUU)

1. Make connection between the 
Keysight B1500A and 
the 16442B Test Fixture using the 
triaxial cables.

Keysight 16442B Test Fixture

SMU 4

SMU 3

SMU 2

SMU 1

Triaxial cable

Note: 
The actual SMU configuration delivered to you may 
differ from the figure.  In that case, connect the triaxial 
cables in order to the B1500A SMU and the 16442B test 
fixture.

SMU 1   SMU 2 

GNDU

Keysight B1500A SMU

1
2
3

4

TO 
SMU 4

TO SMU 3

SMU 4
to

SMU 3
module

SMU3
to 

SMU 4
module

 

Step 2: Optional Configuration 3 

B1500A configured with SMUs and MFCMU with 16442B Test Fixture: 

B1500A configured with SMUs only: 
This page shows the cable connection in the case of the B1500A configuration without SCUU. 
SMU connection: 

Connect the Force terminal of the SMU and the 16442B in the order from SMU 1 to SMU 4 as 
shown in the slide. 
1. Connect SMU 1 to the SMU 1 terminal of the 16442B. 
2. Connect SMU 2 to the SMU 2 terminal of the 16442B. 
3. Connect SMU 3 to the SMU 3 terminal of the 16442B. 
4. Connect SMU 4 to the SMU 4 terminal of the 16442B. 
 
Note: 
Make sure the SMU 3 and 4 cable to the test fixture is exchanged to the fixture input 4 and 3.  
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B1500A Demo Setup for 16442B Test Fixture: Step 3
Wiring inside the 16442B Test Fixture

• Make connection inside the 16442B Test 
Fixture:
• Connect between SMUs and the 

connection pins of the 28 pin dual in-
line socket as shown in the picture:
- SMU 1 - pin 1
- SMU 2 - pin 2
- SMU 3 - pin 3
- SMU 4 - pin 4

SMU 1   SMU 2   SMU 3  SMU 4
SMU 1   SMU 2

Triax cable connection (back side of the 16442B)

Pin 1

Keysight 16442B Test Fixture

D G Sub
Pin 4

SMU 4
to

SMU 3
moduleSMU3

to 
SMU 4
module

Pin 1     2      2     4

SMU 1           SMU 2          SMU 3          SMU 4

 

Step 3: Only for 16442B Test Fixture 

Wiring inside the 16442B Test Fixture: 

 Connection: 

Make connection between the SMU output of the 16442B Test Fixture and  
the 28 pin dual in-line socket using pin - mini-banana test lead:  
- SMU 1 - pin 1 
- SMU 2 - pin 2 
- SMU 3 - pin 3 
- SMU 4 - pin 4  
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1-4. Demo Device 
 

2. For 16442B Test Fixture:
• Form the SD214DE leads to fit to 

dual in-line socket module.

B1500A Demo Setup: Demo Device
SD214DE MOS-FET  and leads forming for Test Fixture

S D G Sub

• Original SD214DE (Left picture)
• Formed SD214DE (Right picture)

Note: Keep the shorting wire 
while forming the leads

TO SMU 1
of

Test fixture

SD214DE pin assignment

TO SMU 2
of

Test fixture

TO SMU 4
of

Test fixture

TO SMU 3
of

Test fixture S   D   G Sub
In line

1. For N1295A Test Fixture:
• Use without forming the leads as 

shown in left .

Pull out the shorting wire when 
set to the socket

Pull out the shorting 
wire when set to the 

socket

Warning:
• There is no protection diode connected to the 

gate, and it is damaged very easily.
• When handling the device,  keep the following:

- Do not touch to the gate pin.
- Discharge your body charge by touching to 
Earth ground level.

S
D G

Sub

 
Demo device: 
Slide shows the 4 terminal Demo MOS FET. 
The commercial name of the FET is SD214DE. 
SD214DE basic characteristics: 

 - Nch MOS FET 
 - Max Vd : 10 V 
 - Max Vg : 10 V 
 - Max Id : 50 mA 
 - Vth : <1.5 V 
 - Typical Ig : <1 pA 

Device leads forming: 
Device leads forming is necessary to fit to the socket of the test fixture. 

1. For N1295A Test Fixture: 
There is basically no device lead forming is necessary, but it may be easier to insert the socket by 
bending a little bit as shown in the picture. 

2. For 16442B Test Fixture: 
Form the leads as shown in the above figure so as it fit to the 28 pin dual in-line socket of the 16442B 
Test Fixture. 

 
Note: While forming the leads, keep the shorting wire to protect the gate from any damage. 
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B1500A Demo setup: N1295A Test Fixture
Test device connection with N1295A Test Fixture

• Form DUT leads and set DUT to the 
28-pin dual in-line socket. 
- Pin 1: Source
- Pin 2: Drain
- Pin 3: Gate
- Pin 4: Sub

Pull out the shorting 
wire when set to 

the socket
S

D
G

Sub

Keysight N1295A Test Fixture

2: to SMU 2 

4: to SMU 3

3: to SMU 4

1: to SMU1
Source

Drain
Gate

Sub

 
 

Test device connection with N1295A Test Fixture: 
 
Connect the Demo device (4-terminal MOS FET) as shown in the slide. 

 

 To Set Device: 

 
• Form the device leads so as it can fit to the N1295A device socket. 

- Check previous slide for #1- N1295A Test Fixture. 
 

•  Set the devise to the N1295A Test Fixture as shown in above slide. 
- Source - #1 pin 
- Drain - #2 pin 
- Gate - #3 pin 
- Sub - #4 pin 
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Make the Demo device (4 terminals MOS FET) connection as shown in the slide. 

 

 To Set Device: 
• Make connection between the SMU output of the 16442B Test Fixture and   

the 28 pin dual in-line socket using pin - mini-banana test lead: 
- SMU 1 - pin 1 
- SMU 2 - pin 2 
- SMU 3 - pin 3 
- SMU 4 - pin 4 

 
• Form the device leads in the order of Source, drain, Sub and Gate 

- Check previous slide for forming the FET leg leads. 
 

•  Set the device to the 28-PIN Dual In-Line Package Socket 
 
  

B1500A Demo setup: 16442B Test Fixture
Test device connection with 16442B Test Fixture

1. Form DUT leads and set DUT to the 
28-pin dual in-line socket. 
- Pin 1: Source
- Pin 2: Drain
- Pin 3: Gate
- Pin 4: Sub

2. Make sure the connection between 
the SMU output to  the 28 pin dual 
in-line socket as shown in the right 
side picture: SMU 1   SMU 2   SMU 3  SMU 4

SMU 1   SMU 2

Triax cable connection (back side of the 16442B)

Check previous page for 
FET's lead forming

Pull out the shorting 
wire when set to 

the socket

Pin 1

Keysight 16442B Test Fixture

DUT
S D G Sub

Pin 4
Pin 1 Pin 4

SMU 4
to

SMU 3
moduleSMU3

to 
SMU 4
module

Wire connection

B1500A Demo setup: 16442B Test Fixture
Test device connection with 16442B Test Fixture

1. Form DUT leads and set DUT to the 
28-pin dual in-line socket. 
- Pin 1: Source
- Pin 2: Drain
- Pin 3: Gate
- Pin 4: Sub

2. Make sure the connection between 
the SMU output to  the 28 pin dual 
in-line socket as shown in the right 
side picture: SMU 1   SMU 2   SMU 3  SMU 4

SMU 1   SMU 2

Triax cable connection (back side of the 16442B)

Check previous page for 
FET's lead forming

Pull out the shorting 
wire when set to 

the socket

Pin 1

Keysight 16442B Test Fixture

DUT
S D G Sub

Pin 4
Pin 1 Pin 4

SMU 4
to

SMU 3
moduleSMU3

to 
SMU 4
module

Wire connection
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1-5. B1500A EasyEXPERT Setup 
The following operations are covered in this section. 

Step 1. Turn on the Keysight B1500A 
Step 2. Starting the Keysight EasyEXPERT 
Step 3. Preparing for User Demonstration of the Keysight EasyEXPERT 

 
 

Step 1. Turning on the Keysight B1500 
 
After you receive the B1500A, perform the following setup. 

1. Make sure that the Standby switch is set to off. 
2. On the B1500A rear panel, make sure the Circuit Common terminal is 

connected to the frame ground terminal with a shorting-bar. 
3. Connect the Keysight 16444A-001 USB keyboard and the 16444A-002 USB 

mouse to the USB port of the B1500A. 
4. Connect the power cable from the B1500A to an AC power outlet. 
5. Open the measurement terminals (disconnect measurement devices if 

they are attached), and press the Standby switch (lower right corner of the 
front panel) to turn on the B1500A. 
Windows, measurement module initialization, and self-calibration will 
start. 

6. The default Windows setup logs on to Windows automatically by the 
“Keysight B1500 User” which should be fault user of the B1500A. 

 
 
 
Note:  
If you are the first user of the demonstration B1500A shipped from the 
Keysight factory, then you are required to perform the initial setup of the 
Windows operating system of the B1500A. 
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Step 2. Starting the Keysight EasyEXPERT 
 
After logging on, click the Start EasyEXPERT button. 
Wait until EasyEXPERT is activated. 
 

 
          
 

Note:  
If you close the Start EasyEXPERT window, you can run it again  
by clicking the following Start EasyEXPERT short cut  
on the Windows desktop. 
 

Note:  
If the Welcome to Microsoft Windows screen appears instead of the above 
screen, it means that you are the first user of the demonstration B1500A 
shipped from the Keysight factory. 
Please perform the initial setup of the Windows operating system by following 
the instructions in the section “To perform Windows Initial Setup” in 
Appendix A. 

          

Start EasyEXPERT button/window 

Start EasyEXPERT icon 
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Just after the Windows initialization, the EasyEXPERT start up window opens with one of the following 
three cases.  
Follow the instruction to setup the EasyEXPERT demo workspace. 
Case 1: First time use 

 
 
Case 2: One existing workspace 

 
 
Case 3: More than two existing workspace 

 

Close Workspace by selecting "Close 
Workspace” from the “File” menu,  
and return to the EasyEXPERT 
workspace management window. 

Click "Close Workspace" change 
the windows to "Case 2" 
Workspace Management 
window. 

Check the "No, I want to start a new 
session" radio button. 
Go to Step 3 of next page to create a 
new Workspace for demo use. 

Workspace Management window 

Go to Step3f of two pages from this 
page and create a new Workspace for 
demo use. 
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Step 3. Preparing for User Demonstration Workspace of the Keysight 

EasyEXPERT 
Step 3a. Select the "No" radio button and click Next 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Step 3b. The following Workspace Configurator appears. 

Enter, say, “Demo Workspace XX” as a unique name new  
workspace in the new workspace entry field. 

Step 3c. Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Go to Step 3d of next page. 
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 (Continued : Demo Workspace setup)  
Step 3d. Click the new "Demo Workspace XX" to highlight it. 
Step 3e. Click Continue. 

 
 
 
 
 

Go to "Step 3j" of next page. 
 
 
 
 
 
 
 

 
 
Step 3f. Creating a new Workspace. 
If two or more workspaces already exist, B1500A displays the following Workspace Configurator. 

 
 
Step 3g. Click "Create a new Workspace 

 radio button 
 
Step 3h. Enter, say, “Demo Workspace XX”  

as a unique name new workspace  
in the new workspace entry field. 
 

Step 3i. Click Continue 
 
 

 Go to "Step 3j" of next page. 
 

 
 
Note: 

Workspace means the space created in the Keysight B1500A’s internal hard 
disk drive, and is used to store the measurement setup, measurement result 
data, and so on. The workspace can be created and allocated for each user  

3g 
3h 

3i 

Demo Workspace XX 

3d 

3e 
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Step 3j. The following new EasyEXPERT initial window opens. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step 4. Importing Demo Results data 
Now we are in the final demo setup stage. 
 

Follow the following steps. 
Step 4a. Insert the User Demonstration CD in the CD Drive. 
Step 4b. Import Demo Data:  

- Click > Results >> Transport data >> Import. 
  Then select the file B1500A_QuickStartGuide_Data.ztr from the DVD/CD-RW. 

(B1500A_QuickStartGuide_Data.ztr is downloadable form the Keysight web site, too.) 
- The Demo Data set is imported and appears in the Results area. 

 
Now we are in the final demo setup stage.  
  

Step 4b. 
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Step 5. Importing Demo Measurement Setup 
 

- Click > My Favorite Setup >Preset group > Import Preset Group 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  Then select the file B1500A_QuickStartGuide_FavoriteSetup.xpg from the DVD/CD-RW. 

(B1500A_QuickStartGuide_FavoriteSetup.xpg is downloadable form the Keysight web site, too.) 
 
- The demo measurement setup file set is imported and  
  appears in the My Favorite Setup: “Demo” group. 

 
 
Now the “User Demo WS” is created and the User Demo Setup is completed. 
 
Return to the main section to continue the user demonstration. 
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Step 6. Preparing the B1500A environment: 
 

B1500A Demo Setup: EasyEXPERT

Power Line Frequency Setting

1

2

3

 

Power Line Frequency: 
Power line frequency setting is very important for accurate and stable measurements in low signal voltage 
or current. 
 
Please check your line frequency setting of your Demo B1500A. 
If the line frequency is set differently from the line frequency of your area, please set it correctly. 

 

• To Change: 

• Click "Configuration" button. 
• Configuration window opens. 
• Click Line frequency button to open the line frequency list. 
• Select 50Hz or 60Hz. 
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1-6. B1500A EasyEXPERT Basic Information 
This section covers the following topics: 
o Online Help 
o Managing Workspace 
o Reviewing Measured Demo Data in the User Demonstration Kit 
o Recalling Test Setup for User Demonstration 
o Modification in the Demo Test Setup parameters 
o Saving New Test Setup to My Favorite Setup 
o Exporting or Importing My Favorite Preset Group Setup 
o Demo Data Recalling 
o Measurement Setup Order 
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Online Help 

B1500A Demo Setup: EasyEXPERT Hint!

Online Help

1.

2.

 

 
Online Help is available for EasyEXPERT.   
Select “Help > Keysight EasyEXPERT Help menu" to display the online help window.   
 
• The online help provides the following information. 

• Introduction 
• Using EasyEXPERT 
• Function Details 
• Built-in Programming Tool 
• If You Have a Problem 

 

 To Display: 

• Select "Help > Keysight EasyEXPERT Help menu". 
• "Help” window opens. 
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Managing Workspace 
At this point, the Demo Workspace should be created already. 
 
However if you find this workspace includes too much data that was created in the previous User 
Demonstration and that it is annoying to start your demonstration, you can delete the previously created 
Demo Workspace and create a new Demo Workspace. 
 
Deleting the existing Workspace 
 You can delete the existing Workspace using Manage Workspaces in the 

Workspace Configurator. 

 

 
 After deleting the existing Demo Workspace, a new Demo Workspace 

including only the default User Demonstration data can be created.   
In this case, you have to import Demo data as instructed in B1500A 
EasyEXPERT Setup, Step 4 and Step 5. 
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Reviewing Measured Demo Data in the User Demonstration Kit 
 
The Keysight B1500A User Demonstration Kit includes several sample measurement setups and data 
measured using the demo device. 
 
You can refer to these setups and data when performing your User Demonstration. 
 
The Initial User Demo Workspace includes the following measurement setup and data. 

 
 
You can check the sample Library setup and measurement  
data by recalling one of the highlighted measurement results  
by right-clicking the mouse. 
 
You can recall both the Library setup information (left) and the Data Display window (right) as in the next 
figures. 
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Recalling Test Setup for User Demonstration 
 
The measurement setup can be saved in My Favorite Setup. 
The Keysight B1500A User Demonstration Kit includes measurement setups used in the Demo in the My 
Favorite Demo Setup; you can recall the setup when you make measurements for the demo device. 
 
My Favorite Demo Setup group 

You can choose the Demo preset group in the dropdown menu of My Favorite 
Setup. 

    

 
 
 
 
 
 
 
The test setup parameters are recalled by  
selecting one of the My Favorite Demo setups  
and pressing the Recall key. 

  

Mouse 

Soft key 

The User Demo setup 
appears in the  
My Favorite Setup. 
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Modification in Demo Test Setup Parameters 
 
The test setup parameters in My Favorite Demo Setup are appropriately set for measuring the Demo 
device. 
Nevertheless, the SMU configuration must be checked and modified appropriately according to the 
actual B1500A configuration and the Demo Device connection.  
This is because the SMU configuration varies for each Demo B1500A, and the connection in the Demo Test 
Setup might differ from your demo B1500A configuration. 
 
The check points for the SMU connection are marked (  ) in the figure below. 

Please check the SMU connection before you press the single measurement button. ( ) 
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Saving New Test Setup to My Favorite Setup 
 
You can change the Test Setup parameters recalled from My Favorite Demo Setup and save them to My 
favorite again in the same Demo group or new group that you have created. 
 

Or you can select any Library test definition and modify the parameters for your test device, and then you 
can save the test setup to a Preset Group of My Favorite Setup as your test definition.  You can use this 
definition repeatedly with no change in later use. 
 
You can change the test setup name when you save it. 
 
 
The flow for saving your test setup to My Favorite Setup 

 
 
 
  

Change Test 
Parameters 

Select Test 
Definition 

Recall Test 
Definition 

Change Test 
Setup Name 

Save Test 
Definition 

You can create Preset Group 
in My Favorite Setup 
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Exporting or Importing My Favorite Preset Group Setup 
 
The Test Setup definition saved in My Favorite can be exported to the Windows file system or imported 
from the Windows file system as Preset group level. 
 
You can share the test setup between different B1500As, different Windows login users or different 
Workspace using this capability. 
 
Note: 
When importing My Favorite Setup, the original Library must be located in the Application Test Library. 
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Demo Data Recalling 
 

Demo Setup & Data Recalling

Id-Vg Demo
recalls
both .. 

Demo Data 

Demo Setup 

 
All the test definitions of user demonstration used in the Demo manual include the demo setup of the 
measurement parameters and the measured data. 
 

You can recall both the test definition and the demo data display by recalling the demo result in the Results 
area. 
Try the following; 
 You can explore the Data Display features before starting the actual  

measurements on the Demo device. 
 You can use the test setup for measurements.  

Check the SMU connection before pressing a single measurement button. 
 

Note: 
1. All the measurement data is stored automatically in the Results area. 

Therefore the Results area might include too much data measured  
in previous B1500A demonstration. 

2. If you find it difficult to find the original demo data, you can delete all the 
data and transport the original data from the User Demonstration CD ROM. 
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Measurement Setup Order 
 

Measurement sequence

Change Test 
Parameters:
- SMU setting
- Parameters  

Select Test
Definition

Recall Test
Setup

Single 
measurement

Select 
Category

General Test Setup Flow

Test flow using an existing 
My favorite setup

Select My 
Favorite 
Setup

 

The slide shows two ways that you can start measurements. 
1. General Test Setup flow using Library template 
   Perform the following test setup sequence: 

1. Choose test category of the Library. 
2. Choose test definition from the Library. 
3. Change the test parameters. 
4. Press single measurements.  

 

2. Demo Test Flow 
   Recall the test setup and execute tests: 

1. Choose and recall a test setup from My Favorite Demo Setup. 
2. Check the SMU connection, if the file is imported from a differently configured 

B1500A. 
3. Press single measurements. 
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2. User Labs 
User labs start from this section. 
User labs cover following topics: 

 
Lab 1. Getting Used To EasyEXPERT 

• What is Application Test? 
• Id-Vd application test 
• Power off the B1500A 

Lab 2. “Vth gmMax” application test 
• What is Vth gmMax Measurement? 
• Perform Vth gmMax application test 
• Graph Analysis Functionality  

Lab 3. Id-Vg Vth Measurement using classic test 
• What is Classic Test? 
• Creating Id-Vg Vth Classic Test with Auto Analysis 
• Compare the result using Append mode 

Lab 4. Id-Vg Tracer Test 
• What is Tracer Test? 
• Creating Id-Vg pulsed mode Tracer Test 
• Perform Measurement using Tracer Test Features 
• Convert Tracer Test mode test to the Classic Test mode 

Lab 5. CV Measurement with SCUU 
• IV/CV measurement dilemma and SCUU 
• CV test setup using CV Sweep Classic Test mode  
• Measure sequentially with 1 MHz and 100 kHz test signal 

Lab 6. 100 us Sampling Measurement  
• Overview of sampling measurement 
• The relation between setting and actual interval 
• Creating 100 us sampling measurement  

Lab 7. Quick Test 
• What is Quick Test? 
• How to execute Quick Test. 

Lab 8. Reporting 
• Desktop EasyEXPERT 
• Display/Recall Data 
• Copy Graph 
• Copy List data 
• Export/Import Results Data 
• Export/Import My Favorite Preset group 

Lab 9. Ultra Low Current Measurement using ASU 
• What is ASU? 

 
 



 

• ASU configuration 
• ASU/SMU zero cancel calibration 
• Id-Vg Sub-threshold Ultra-Low Current Measurement 
• Low current measurement tips and related labs 

Lab 10. Pulsed IV Measurement Using 50 μs pulsed MCSMU 
• What is MCSMU? 
• MCSMU Configuration with the N1255A 2 channel connection box for MCSMU 
• Perform Id-Vd Pulsed IV test 

 

 
 



Lab 1: Getting used to EasyEXPERT through Application Test

Lab 1 covers following topics.
1. What is Application Test?
2. Demo device setup
3. Perform Id-Vd application test

- Test Result Editor - Auto data save
- EasyEXPERT Tips
- Setup Id-Vd test and measurement
- Single/Append/Repeat measurement
- Save and recall setup/measurement data

4. Power off the B1500A
5. Summary
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What is Application Test?
The Application Test includes;
1. A library of pre-defined tests that eliminate the need to manually specify most of the instrument 

parameters for common tests (such as Id-Vd measurements). 
2. The user can perform a measurement through an intuitive “fill in the blanks” procedure. 
3. Measurements are performed with just the simple click of the measurement button.
4. And parameters are automatically extracted.

You can choose a suitable test definition from more than 300 application test definitions in sixteen 
application test categories of B1500A`s Application Test Library.

If the test definition does not meet to your requirement, you have two options as;
1. Modify and customize the existing application test definition, or
2. Create a Classic Test mode test definition that is shown in "Demo 2" section.
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Let`s start the Lab.
The slide shows the Id-Vd Demo test setup recalled from My Favorite Demo Setup.

To import setup from My Favorite Setups
Refer to the 1-4. B1500A EasyEXPERT Setup > Step 5. Import Demo Measurement Setup

To recall setup from My Favorite Setups:
1. Set My Favorite group to "Demo".

To select, click        of My Favorite group window.
2. Select "Id-Vd Demo" test definition icon.
3. Click Recall.
4. The pre-defined Id-Vd Demo test opens.

Setup name is also changed to Id-Vd Demo although the master library name is "Id-Vd" 
(see #5) 

Demo instruction:
6. Check if the SMU connection matches your B1500A configuration (SMU type and your 

demo device.
- If the SMU type is different (e.g. HPSMU, MPSMU, HRSMU), select the right SMU type 
of your B1500A.

7. Press single measurement button, and see the output.
The measurement start.
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Data Display and Save
After you click the single measure button, 
1. Test Result window showing the measurement data of Id-Vd Demo application test opens
2. Test Result Editor that pops up after each measurement.

To Save Your Data:
• The default setup saves all of your measurement data to the "Test Record List area" if you 

do not click "Delete" button of "Test Result Editor".
• You can add Flags (status of your test result) and Remarks to your test result, and you can 

use these parameters for filtering your test results when you make a reporting. 
- You can just ignore this window if there is no comment on the measurement result.

The data is saved automatically with your next action.
• If you do not like to save this test result, simply click "Delete" button.

Even in this case, the data is actually saved with "Delete" flag in background.

Making Analysis on your data:
You can make analysis on your measurement data as the following way;
• Add Marker, Cursor, and Lines on the graphics and extract parameters.
• Add another line with the existing data.
• Export your data to Windows application in easy way.
These topics will be covered in another Lab.
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Procedure(3) Save and Recall 
After the measurement, you may want to save the test setup if the test is performed as you satisfy 
the results.
And later, you may want to recall the data for review.

To save setup data:
You can save the setup data to one of the group of "My Favorite Setups"
You can create My Favorite Setup group and save in the group.
Note: The test setup can be exported and imported by the group level.
• To create new group:

1. Click "My Favorite Setups". -> "My favorite Setup" menu opens.
1a. Click "Preset Group" -> "Preset Group" menu opens.
1b. Click "Add New Preset Groups" -> "Group Name" input windows pops up.
1c. Enter new Group name, for example "Demo-1".
1d. Press "OK" crates new preset group.
• To save and recall application test setup:

2. Enter new Setup name to "Setup name" field, for example, Id-Vd Demo1
2a. Click "save" button saves the test setup to "My Favorite Setup group"
2b. Select test setup and Clicking "Recall" button recalls test setup.

To recall measured data:
3. Highlight the result data line of the "Test Record List" area.
3a. Click "Results" button or right click on the data line -> opens the "Results" menu.
3b. Click "Display Data": Only the measured data display window opens.

Click "Recall": Recalls both the setup and measured data
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Tips: Application Test Description

Each application test includes its test description.
The test description includes brief test definition and the descriptions of the input and the output 
parameters used in the test.

To know about the application test:
1. Click the ( i ) icon.
2. This icon displays the message box that explains the application test definition. 

This function will help you to know what is and how to use the application test.
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Tips: Typical Value Selection
When you set a test condition of application test, you do not need to use keyboard.  
You can select the value from the typical values as shown in above slide.

To select value:
1. Click the entry field of a setup parameter by using the touch screen or the mouse.  

This displays the typical values for the specified parameter on the softkeys.
2. Select one of the softkeys.

Also you can use the following manner.
- Point the entry field of a setup parameter by using the mouse. 
- Right click the mouse to display the popup menu.
- Click the Select menu to display the typical values for the specified parameter.
- Select one from the typical values.

Note:
The typical values are defined in the test definition.
And you can change the values by using the Define typical values window opened by 

clicking the Typical Values button on the Test Specification screen of the Test Definition 
window.  
For the Test Definition window, see users guide.
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The EasyEXPERT provides three execution modes, Single, Append, and 
Repeat.

Single Measurement:
1. Press Single button to trigger a single measurement.

The previous measurement data on the data display is cleared automatically before the 
measurement.

Append  Measurement:
1. Press Append button to trigger an append measurement. 

The measurement results will be appended to the Data Display window that shows the 
previous measurement results. You can use this mode to check the difference between the 
traces. The Data Display window can have maximum 10 layers for displaying measurement 
results.

Repeat Measurement:
Repeat measurement performs a specified number of continuous repeat measurements.
1. Click Repeat button
2. A dialog box opens. (Note: Only under "Record Test Result Automatically" mode.)
3. Uncheck "Procedure Return Condition".

Reset Counter and enter, say "3", to "Counter Reaching to" field.
Measurement will be stopped after counter reaches to 3.

4. Click Run button to start repeat measurement.

To Abort Measurement:
• To abort measurement, click Stop button that appears instead of the Single button.
• To reset the counter, click the reset button.
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Test Result Editor:
After the measurement, the Test Result Editor shown above is displayed.
Set the parameters depending on your requirements. You can search your test results by using 
these flags.

Note: If the Auto Record function or the Auto Export function is not set to ON, Test 
Result Editor won`t open automatically.
Check the status indicator at the bottom of the screen. (check next page)

◆To re-open the Test Result Editor:
1. Select re-open data in the Test Record List area.
2. Click  "Results" button and opens the function menu
3. Select "Edit > Flag & Remarks".
4. Test Result Editor re-open.

◆To search the test results
1. Click "Results" button and opens the function menu.
2. Select "Filter > Filter…"
3. Enter the filter condition in the "Data Filter" window
4. Click "OK"
5. Filtered test results are displayed in the Test Record List area.
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Tips: Controlling Auto-Record ON/OFF
When you are exploring the device characteristics, there typically appears useless data such as 
resulted by miss-wire-connection, incorrect measurement parameters or wrong SMU assignment.

The default setup of EasyEXPERT always opens Test Result Editor, and it automatically saves the 
data to Test Record List area if you do not click "Delete" button. This also happens in Repeat 
measurement.
Sometimes pressing "Delete" is tedious for useless data.

The RUN Option can control this behavior.
If you set "Auto Record" to "OFF", then you can save only the necessary data.

To set "Auto Record" to "OFF":
1. Click "Run Option" -> "Run Option window" open.
2. Uncheck "Record Test Result data Automatically" check box.

The status indicator is changed to "Auto Record OFF".
3. Click "Close" closes "Run Option" window.
4. Press Single measurement button.
5. Data Display window opens.
6. "Record "indicator appears.

- If you ignore, there will be no data recording on the data.
- If you click the icon, then "Test Result Editor" opens.

To set "Auto Record" to "ON":
Do the same way as to make it OFF except 
7.    Check "Record Test Result Data Automatically" check box..

The status indicator is changed to "Auto Record ON".
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Turning off the Keysight B1500A
1. Disconnect Demo device before turning off the B1500A
2. Exit EasyEXPERT by File > Exit, and wait until Start EasyEXPERT window appears
3. Press the Standby switch (lower right corner of the front panel), or perform Windows shutdown 
from the Start menu.

EasyEXPERT is closed and Windows will be safely shut down and the Keysight B1500A will enter 
the standby state.
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Lab 1: Summary

We learned the topics/items listed in above slide through measuring id-Vd application test.
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Lab 2: “Vth gmMax" Application Test

Lab 2 covers following topics.
1. What is “Vth gmMax” application test?
2. Perform “Vth gmMax” application test.

- Setup “Vth gmMax” application test and measurement.
- Y axis Auto/Manual -scaling and to display hidden Yx (2,3,..) axis scale .
- Marker function.
- Line function.
- Add text to the graph.
- Saving the edited results.
- Measurement without recording test result automatically.

3. Summary
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What is “Vth gmMax” application test?
The slide shows the GUI of the "Vth gmMax" application test (left)
and the Data Display graph that appears on measurement or when recalling the data (right).

The output of the "Vth gmMax" application test  shows the following output in three categories in 
Data Display window.
1. Graph area

Graph area shows the measurement and analysis graphs with marker, cursor and lines.
The figure shows;
2. Id-Vg curve (in linear scale).
3. Gm curve.
4. Log scale Id-Vg curve.

This is useful for checking the low current characteristics of the MOSFET.
5. In the parameters area,

6. The extracted parameters on the graph analysis are shown;
- Vth
- gmMax

7. In the List Display area, following parameters are listed in number format:
- Vgate
- Vsource
-Vdrain
- Vsubs
- Idrain
- gm
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Note: Vth definition of “Vth gmMax“
The definition of the threshold voltage Vth used in the "Vth gmMax" application test is

Vth=Von-(Vd/2)
where,

Von is the Vgs intercept of the tangent line drawn on the Id-Vg curve at the maximum 
gradient point.
Vd is the drain voltage applied to the drain for measuring Id-Vg characteristics.

To find the maximum gradient point of Id-Vg characteristics:
EasyEXPERT takes the following steps to find the Vth;
1. Measure Id-Vg characteristics.
2. Create Gm curve by differentiating the Id-Vg curve.
3. Find maximum point of Gm curve, the X-coordinate.
4. Put a marker on the X-coordinate find in step 3 on the Id-Vd curve.

This is the maximum gradient point of the Id-Vg curve.
5. Draw a tangent line on the marker of Id-Vg curve.
6. The intercept of this line on the Vgs X-axis is Von,

and the Vth is calculated by Vth=Von-Vd/2.
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Set parameters on "Vth gmMax"

"Vth gmMax" application test is set up from the Application Test Library.
Follow the next steps to enter the necessary parameters;
1. Click "Application Test" mode.
2. Click and put check mark to "CMOS" category.
3. Find and click "Vth gmMax" application test icon.

3'. Search function is easier to find the target application: enter "gm" to the search field.
Only the application name that includes "gm" character appears in the Library field.

4. IntegTime: Set to "Medium"
5. Gate group: Set the followings,

- Gate: SMU 3
- VgStart: -500 mV
- VgStop: 3 V
- VgStep: 50 mV

6. Drain group: Set the followings,
- Drain: SMU 2
- Vd: 100 mV

7. Subs group: Set the followings,
- Subs: SMU 1
- Vsubs: 0 V

8. Source: Set to "SMU 4"
9. IdMax: Set to "2 mA"

Note that this value is used as a maximum Y axis value for plotting the drain current.

Note: Recalling from My Favorite
You can recall the predefined  test setup from the 
Demo group of My Favorite  Setups.
• Check #10 
• Select "Vth gmMax Demo" icon and click "Recall 

"button.
• Check if proper SMUs are set .
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Procedure(2)
To Set up Demo MOSFET
Connect the demo MOSFET before the test.
Refer to the demo device setup section of Lab 1 module.

To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.

This is especially important when the measurement covers a wide current range from sub-
pA to a mA range. 

2. Note:
Before the measurement make sure the "Auto Record" function is set to ON status.

3. If there is no check on the "Record Test Result Data Automatically", then check it.
The Status indicator should show "Auto Record ON".

4. Click Single Measure button.
Measurement starts.

5. The gmMax Vth Display window appears.
The data is saved to the "Test Record List" at this point.

6. Enter to the Remarks field of the Test Result Editor, say "First Vth measurement" as an 
example, and press "OK".
The data is re-saved by adding the remarks.

Note: If you Click "Delete" button, the data is saved with "Delete" status.
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Y Axis Scaling
You can auto-scale or manually set the scale of the graph display.

To auto-scale the Y2 axis:
The orange Y2 gm data cannot read the value from the graph because the Y2 scale is too large.
We are going to change Y2 axis scale. Follow the next steps.
1. Click the mouse on the Y2 axis area.

The focus of the scale moves to Y2 axis.
Y2 axis shows scale in detail.

2. Click Auto-scale icon on the top of the window.
3. The gm curve shows up, and now you can read gm value from the curve.

Note 1: The line is also moved to Y2 axis in this case.

To show the hidden Y3 axis:
The "gmMax Vth" application test is set Y3 axis as log Id-Vg for observing low current region of 
the MOSFET.
You can toggle between Y2 and Y3 axis.
Follow the next steps.
4. Click the active Y2 axis.

The Y2 axis now shows Y3 axis (bottom figure).
5. Click the active Y3 axis.

The Y3 axis now shows Y2 axis (top figure).
6. To make the Y1 axis to active, click Y1 scale.

Note: Y1 scale does not toggle.
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Manual Scaling
You can scale manually, too.
Sometimes you may want to set the scale manually in such a case to make a reporting.
EasyEXPERT has the manual scaling function to the measured data.

To scale manually:
Follow the next steps;
1. Click the "View" of the menu bar.

View menu opens.
2. Click "Display Setup..." opens Display Setup window.
3. Find  the scale name that you want to change.

In the example, gm in Y2 axis will be changed.
4. Change as follows;

- Min: 0 S
- Max: 2 mS

5. Click Apply
6. The gm axis changes to an appropriate balance in the graph plotting.
7. Click Y1 axis to properly set the line to Id-Vg curve.
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Marker Function:
You can control Marker functionality in several ways.

A. To Control Marker:
EasyEXPERT has the following Marker function.
1. Marker ON/OFF icon enables or disables the marker.
2. Interpolation ON/OFF icon enables or disables the interpolation function of measurement 

data. 
You can read the interpolation data between two actual measurement points.

3. Marker Skip icon moves the marker to the next measurement curve that is added by the 
VAR2 variable.

4. Marker Maximum icon moves the marker to the maximum measurement point.
5. Marker Minimum icon moves the marker to the minimum measurement point.
6. Marker Search icon opens the Direct Marker/Cursor dialog box used to specify the 

coordinate values to move the marker.

B. To Read Marker Value:
The marker position data is shown in the Maker readout field.
The display order of the parameters is, from the left;
X axis value, Y1 axis value and Yx (Y2, Y3, Y4 ...) axis value.

C. To Move Marker:
You can move Marker by one of the following ways.
1. By rotating the rotary knob of the B1500A.
2. By rotating the mouse wheel.
Note: The List Display automatically scrolls to the  marker data line. (#D)

Labs: Move marker and observe the following parameters.
- Is the marker moved?
- How the marker position data changes?
- How the line moves?
- What happens in List Display?
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Line Analysis Function:
"Vth gmMax" application test uses Tangent line function, but EasyEXPERT provides the following useful line functions.

Line control:
1,2. Line 1 and Line 2 state icon:

You can draw two lines, Line 1 and Line 2. 
Each Line State icon enables or disables line 1 or line 2 and its function: 
- Normal line (Draw a line between Cursors -- See #B)
- Gradient line (Draw a line on a Cursor)
- Tangent line (Draw a Tangent line on a marker -- See #C) 
- Regression line (Draw a regression line on a curve surrounded by two Cursors)

3. Cursor to Marker icon: 
Cursor to Marker icon moves the cursor to the marker position.

4. Adjust Gradient icon: 
Adjust Gradient icon is available when a gradient line is active. 
Clicking this icon enables the rotary knob and the mouse wheel to increase/decrease the gradient of the line.  
Clicking this icon again, clicking the rotary knob, or clicking the mouse wheel disables this function.

To Draw a Normal Line:
Follow the following steps to draw and move the lines.
B1. Click Arrow beside the Line 2 icon.
B2. Click Normal.

- A vertical line is drawn on a cursor. (Cursor appears in the center of the graph display)
- Cursor position data line is displayed on top of the graph display (see #B3).

Cursor position data shows X value, Y1 value and Yx value of the active cursor. 
B4. Click on a cursor, and move the mouse (or move on the touch screen) by keeping hold on (grab) the cursor.

A line is moved between the active cursor (i.e. grabbed cursor) and the non-active cursor.
B5. Click on non-active cursor. Now this cursor is active and the position data is switched to new active cursor position.
B6. Click on Cursor to Marker icon. Active Cursor moves to Marker position.

In this way you can set the cursor to the exact marker position for accurate analysis.
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Adding Text on the Graph Display
You can add text to the graph display area.
Adding text helps when you recall the data.

To add a text:
To add a text, follow the next steps.
1. Click Text > New.  A text editor appears.  
2. Then enter the text you desire. 

For example, "My Vth gmMax analysis". (see #2`)
3. The following functions are available for the selected text(s) via the Text menu.

Clicking on a text will show Text menu. 
- Edit Mode: Edits the selected text. 
- Size: Sets the font size of the selected text(s). 
- Font: Sets the font of the selected text(s).
- Text Color: Sets the text color of the selected text(s). 
- Background Color: Sets the background color of the selected text(s). 
- Hide Frame/Show Frame: Hides or shows the frame for the selected text(s).
- Delete: Deletes the selected text(s).

Note: Dragging a text moves this text.
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To Save Analysis Result
After the analysis, you want to leave the results in a re-usable form.
You can update your test results.
If you do, you can see the all information when you open the graph again.
Note: The modification information will be destroyed if you did not do it. 

TO Save Analysis Result:
Follow the next step to leave the graph modification information,
such as scaling, marker, cursor, and line on the graph.
1. Click the File menu.

File menu opens.
2. Select "Update Test Result" from the menu.

This will update all the modification you made on the data.

To Save Only the Graph Image:
To save only the graph image as a file, 
3.  Select the File > Save Image As… menu.

You can save the image as a bmp, emf, gif, or png file.

Note: The modified data you made will be not saved and destroyed in this case.
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Lab 2: Summary

We learned the topics/items listed in above slide through measuring id-Vg 
application test.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 3: Id-Vg Vth Classic Test

Lab 3 is the same measurement of Lab 2, but on Classic Test.
Lab 3 covers following topics.
1. What is Classic Test?
2. Creating Id-Vg Vth classic test.

- SMU Source Channel Setup
- SMU Output Parameter (VAR1, CONST)
- SMU Measurement Range, ADC Integ
- Analysis Parameters
- Display Parameters (X-Y Graph, List Data, Analysis parameters)

3. Compare the Id-Vg Vth gmMax application test results.
4. Summary
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What is Classic Test?
• Classic Test can be used itself as a standalone test engine and it can define a unique test. 
• The user interface of the Classic Test mode adopts the same concept of the keysight

Semiconductor Parameter Analyzers and anyone can get used to handle this interface easily. 
• Any application or functionality not furnished in the Application Test library can be performed 

using Classic Test mode.
In fact, Classic Test mode represents the fundamental method of instrument control, and all of 
the pre-defined application tests included in the Application Test mode libraries internally use the 
Classic Test mode.

To Use Classic Test mode:
To use the classic test mode, click the Classic Test tab.  And select the execution mode.  
The following modes are available.
• I/V Sweep: For X-Y characteristics measurement of I or V.
• Multi Channel I/V Sweep: For simultaneous multi channel  sweep measurement of I or V.
• I/V List Sweep: For multi channel  I/V sweep measurement using list data.
• I/V-t Sampling: For time-Y characteristics measurement of I or V.
• C-V Sweep: For DC bias-impedance characteristics measurement.
• SPGU Control: For voltage pulse output. Not available for B1505A.
• Switching Matrix Control: For B2200/E5250 switching matrix control. 
• Direct Control: For various measurements (e.g. C-f measurement, Quasi-Static C-V 

measurement) using keysight FLEX commands.
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To Select Classic Test Mode and I/V Sweep Classic Test
I/V Sweep Classic Test mode is used in the demonstration.
You can also use simple "Multi Channel I/V Sweep" Classic Test mode as an alternative.  There is 
no difference in performing Id-Vg test, but there is a minor difference in the user interface when 
setups the measurement parameter.

Follow the next steps to open the I/V Sweep Classic Test mode:
1. Click Classic Test tab

Classic Test execution mode icon appears.
2. Click I/V Sweep mode icon.

Select button appears.
3. Click Select button.

I/V Sweep classic test setup editor with Channel Definition page opens.
(See next page.)
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Define Source/Measure Channels
Click the Channel Setup tab to display the channel definition screen. 

To set Channel Definition:
Follow the next steps to define the Channel Setup page.
1. Enter the Setup Name for the test setup to be defined on the setup editor.

Enter "Id-Vg Vth CT".  Note: The suffix CT denotes "Classic Test mode".
2. List SMUs used for source output:

Note: You can delete unused SMU from the list.
3. Enter the following parameters to selected SMUs. 

• Unit: SMU name or number.  The GNDU (ground unit) can be set instead of a SMU.
• V Name: Variable name for the voltage measurement or source data
• I Name: Variable name for the current measurement or source data
• Mode: Source output mode, V (voltage), I (current), VPULSE (voltage pulse), IPULSE (current pulse), 

or COMMON (ground)
• Function: Source output function, VAR1 (primary sweep), VAR2 (secondary sweep), VAR1’ 

(synchronous sweep), CONST (constant)
V Name and I Name are used to specify the parameters displayed on the Data Display window.  The 
display parameters are selected on the Display Setup tab screen. 

Set the following parameters:
Unit: V Name: I name: Mode: Function:
SMU 1 Vs Is V CONST
SMU 2 Vd Id V CONST
SMU 3 Vsub Isub V CONST
SMU 2 Vg Ig V VAR1

4. (Optional): Time Stamp setup
You can record the measurement timing of each sweep step (VAR1).
In such a case, enter a variable name to this field, for example "Time".
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Define Measurement Parameters
Click the Measurement Setup tab to display the measurement parameter definition screen. 
The Measurement Setup tab screen is used to set the source output value parameters.

To Set Measurement Setup page:
Follow the next steps to define the Channel Setup page.
1. Set Primary Sweep Source: VAR1 parameters.

• Unit: SMU name or number
• Name: Variable name of source output
• Direction: Single (start to stop) or Double (start to stop to start)
• Linear/Log: Linear sweep or Log sweep
• Start: Source output start value
• Stop: Source output stop value
• Step: Source output incremental step value
• No of Step: Number of sweep steps
• Compliance: SMU compliance value
• Pwr Comp: SMU power compliance value

Enter the following parameters:

2. Set Constants: CONST parameters. 
• Source: SMU output value
• Compliance: SMU compliance value

Enter the following parameters:

Unit Name Direction Linear/Log Start Stop Step No of Step Compliance Pwr Comp
SMU4 Vg Single Linear -500 mV 3 V 35 mV 101 100 uA OFF

Unit V Name I Name Mode Source Compliance
SMU1 Vs Is V O V 100mA
SMU2 Vd Id V 100 mV 100 mA
SMU3 Vsub Isub V 0 V 1 mA
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Tips: Generic Idea to Set VAR2
You can use VAR2 instead of CONST for Vd parameter.

To Set VAR2:
Simply set as follows:

1. VAR2 Function setup:
- Set SMU 2 as VAR2 instead of CONST in the Function field of Channel Setup page.

2. VAR2 parameter setup:
- Open Measurement Setup page
- Set following parameters in the VAR2 area

3. Constants area:
Now Vd is moved to VAR2 and only Vs and Vsub parameters are set

4. Setup Name:
- Change setup name as, say, "Id-Vg Vth2 CT".
- Save this setup to "My Favorite Setup".

Unit Name Start Stop Step No of Step Compliance Pwr Comp
SMU2 Vd 100mV 100 mV 100 mV 1 100 mA OFF

Unit V Name I Name Mode Source Compliance
SMU1 Vs Is V O V 100mA
SMU3 Vsub Isub V 0 V 1 mA
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Set Ranging Mode
The dialog box is used to set the measurement ranging mode. 
The available minimum range depends on SMU type.

To Set the Measurement Range:
1. Click the Range button.
2. The SMU Range Setup dialog box opens. Set the following parameters by necessity.

• Unit: SMU name or number
• Name: Variable name for the measurement data
• Mode: Ranging mode, AUTO, LIMITED, or FIXED

Note: For the limited auto ranging, the instrument does not use the range lower than the 
specified range value. 

• Range: Range value
• Range Change Rule: BY FULL RANGE, GO UP AHEAD, or UP AND DOWN AHEAD
• BY FULL RANGE: performs normal auto ranging operation.
• GO UP AHEAD: Set higher range after the measurement when the following boundary 

condition is satisfied.
Condition:  go up boundary = present measurement range × Rate / 100

Note: Next measurement performs normal auto ranging. Recommend using "UP AND DOWN 
AHEAD" rule if there is no specific requirement on this rule.

• UP AND DOWN AHEAD: 
- Set higher range after the measurement when the following boundary condition is satisfied.

Condition:  go up boundary = present measurement range × Rate / 100
- Set lower range while in the measurement when the following boundary condition is 

satisfied.
Condition: go down boundary = present measurement range × Rate / 1000

• Rate: Value used for range changing. 
Specify the Rate value, 11 to 100, which fixes the boundary of the ranging.
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Set ADC/Integration Time
The dialog box is used to select the ADC for each SMU and set the integration time for each ADC 
(high resolution or high speed). 

To Set ADC/Integration Time:
1. Click the ADC/Integ button.

The A/D Converter & Integration Time Setup dialog box opens.
2. A/D Converter Setup:

• Unit: SMU name or number
• Name: Variable name of the measurement data
• ADC: ADC type, HR ADC (high resolution) or HS ADC (high speed)
• Measurement: Compliance side measurement or Force and Compliance sides measurement.

3. Integration Time Setup:
• Mode: ADC operation mode

- AUTO, MANUAL, or PLC for HR ADC
- AUTO, MANUAL, PLC, or TIME for HS ADC

TIME or PLC for the measurements using SMU pulse.
• Factor: Coefficient for the reference value of the integration time.
• Auto Zero: Auto Zero function ON or OFF.  For HR ADC.

Use "OFF" if there is no special requirement on this setting.

HR ADC Set Example:
Integ Time Mode Factor

Short AUTO 8
Medium PLC 1

Long PLC 16
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Set User & Analysis Function
Click the Function Setup tab to display the User Function/Analysis Function setup screen.  (see #1)
The user functions can be displayed on the X-Y Graph Plot, List Display, and Parameters area of the Data 
Display window. 
The analysis functions can be displayed on the Parameters area of the Data Display window.
We setup the same Vth analysis function used in the Lab 2 "Vth gmMax" application test definition.

To Set User Function:
1. Click Function Setup tab.
2. Click "Add" to display the User Function setup line.
3. User Function Setup line appears.
• Name: Function name
• Unit: Unit of the function
• Definition: Definition of the function.  The following identifiers can be used.

-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables

For details, see online help or User’s Guide.
Set the following parameters:
Name: gm Unit: S Definition: diff(Id, Vg)
Tips: To enter the Definition.
It is easier to use Numeric Keypad (See #4) 
4. In the Definition field, open the Kaypad.
5. Click the down arrow of the Variable field.

You can select from the available variable list. This will eliminate typo error and result in faster test 
setup. 
Note: Function field does the same.

6. Finish the definition line.
7. Click Enter to save the definition.
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Set User & Analysis Function (Continued)
To Set Analysis Function:

1. Click "Add" to display the Analysis Function setup line.
2. User Function Setup line appears.
• Name: Function name
• Unit: Unit of the function
• Definition: Definition of the function.  The following identifiers can be used.

-Variables for the measurement/output data used in this test
-Functions defined in the above lines
-Local variables passed from the application test that calls this test as a component
-Built-in functions and global variables
-Read out functions

For details, see online help or User’s Guide.
Set the following parameters:

Name Unit Definition Note
gmMax S max(gm) Search the maximum value of gm

Von V @L1X Find the intercept of X axis of LIne1
Vth V Von-Vd/2 Calculation
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Auto Analysis Line Function Setup
Click the Auto Analysis Setup tab to display the auto analysis setup screen.  
The auto analysis capability allows you to display/move the marker/line on the data graph 
automatically after measurement.  
The above example draws a tangent line at gmMax data point for Y1 data (=Id).

To Draw a tangent Line on a Specific Y1-axis Data Point:
Create an automatic line analysis by following the next steps.

1. Check Interpolation Mode box:  Check this box to enable the interpolation mode. You can 
position marker between measurement points. 

2. Check Enable box to enable Line 1
Line 1, Line 2:  This area sets the line 1 or line 2 automatically displayed and moved to the 
specified position after the measurement. 
This time, we use only Line 1.

3. Select Line Type: Tangent line.
4. Select the effective axis to draw the line: Y1 line
5. Check "Fix" box of Line 1. This will fix the line on Y1 axis.

Note: In the case of Vth gmMax application test, this box is not checked, and the line moves 
when you change the active Y axis.

6. Check "Data Condition" to set a condition to draw a line.
The line is drawn on a data point.

7. Enter a variable name and a condition expression to specify where you want the marker to 
display and draw a tangent line on the marker.
Enter the following condition to set the data condition:
Condition: gm = gmMax
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Define Data Display Parameters
Click the Display Setup tab to display the data display setup screen. 
• The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area in the Data Display 

window.
• The List Display area selects the variables to be listed in the List Display area of the Data Display window.
• The Parameters area selects the variables to be listed in the Parameters area of the Data Display window.

1. To Set X-Y Graph:
Follow the next steps to define the X-Y Graph.
1. Click and check the box  of X: axis input line

The X-axis input field becomes active.
2. Repeat to click Add button for adding an additional line.

Y1, Y2 and Yx scale input field opens.
3. Enter the following parameters:

2. To Set List Display:
Follow the next steps to define the X-Y Graph.
1. Click Add button. 

List parameter line appears.
• Select:  Vg_sub

2. Click Add button again. 
• Select:  C. 
• Repeat this process and select the following parameter to list:

Vs, Vd,  Freq 

Axis Name Sharing Scale Min Max
X Vg (None) Linear -500 mV 3 V
Y1 Id (None) Linear 0 V 2 mA
Y2 gm (None) Linear 0 S 2 mS
Y3 Id (None) Log 100 fA 10 mA
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Define Data Display Parameters (Continued)

To Set List Display area:
Follow the next steps to define the List display.
1. Click Add button. 

List parameter line appears.
• Select:  Vg

2. Click Add button again. 
• Select:  Vs 
• Repeat this process and select the following parameter to list:

Vd,  Vsub, Id, gm

To Set Parameters area:
Follow the next steps to define the Parameters area.
1. Click Add button. 

List parameter line appears.
• Select:  Vth

2. Click Add button again. 
• Select:  gmMax  
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Id-Vg Vth classic test measurement
To Set Demo MOSFET
Refer to the demo device setup section of Lab 1 module.

To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.

This is especially important when the measurement covers a wide current range from sub-
pA to a mA range. 

2. Note:
Before the measurement make sure the "Auto Record" function is set to ON status.

3. If there is no check on the "Record Test Result Data Automatically", then check it.
The Status indicator should show "Auto Record ON".

4. Click Single Measure button.
Measurement starts.

5. The Id-Vg Vth data display window opens.
Note that the maker and line are automatically shown up as specified in the setup.
- Rotate rotary knob and check the data in Marker field. Is the line moves? 
- Change the active Y axis to Y1. Is the line moves as like Vth gmMax application test?

6. Just Click "OK" to save the initial data.
If you want to save the data after you move the mouse, you have to do "File -> Update Test  
Result".
In the case where "Record Test Result Automatically" is unchecked, then you move the 
marker -> save the data will save the updated data.

Note: If you Click "Delete" button, the data is saved with "Delete" status.
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Lab 3: Summary

We learned the topics/items listed in above slide through creating and measuring Id-Vg Vth 
classic test.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 4: Id-Vg Tracer Test

Lab 4 covers following topics.
1. What is Tracer Test?
2. Creating Id-Vg tracer test.

- Tracer Test measurement setup example
- SMU Source Channel Setup /Pulse
- Graph display setup
- SMU Output Parameter (VAR1, CONST)
- Pulse parameters, ADC Integ time (measurement time)
- Knob sweep
- Reference Trace, Stop Condition and Replay function
- Vth extraction using regression line function

3. Converting the Tracer Test mode definition to the Classic Test mode definition
4. Summary
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What is Tracer Test mode?
The Tracer Test mode provides traditional and familiar curve tracer functionality, permitting quick 
device characterization with minimal measurement setup effort. An innovative automatic
recording feature prevents data loss even if the device under test (DUT) is inadvertently destroyed. 
In addition to these impressive measurement capabilities, the intuitive EasyEXPERT software 
environment makes data analysis a snap. You can also easily export data into your PC-based work 
environment and use this data to generate presentations and reports.
The pre-defined setup menu of the Tracer Test mode makes the IV test setup a lot easier especially 
in complicated setups such as pulsed measurement.  This setup can be converted to the Classic 
Test mode test definition, and it is a convenient functionality for creating a classic test from a 
scratch.
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Open Tracer Test mode & Set the SMU Channel Definition
Follow the next steps to setup the SMU resources.

1. Click Tracer Test tab.
Tracer Test mode screen shown in above slide opens.

2. Click "Sample setups" menu.
Sample setup menu pops up.

3. Select "MOSFET" category  opens MOSFET tracer test definition menu.
4. Click "ID-VGS" setup.

ID-VGS setup appears.
5. Re-assign the Drain and the Gate SMU to SMU2 and SMU4:

- Replace  Drain SMU to SMU 2.
- Replace Gate SMU to SMU 4.

6. We are adding "Source" and "Sub" SMUs.
Click "Add" opens available SMUs list for adding to the  source and measure unit list area.

7. Add available SMUs from the list by clicking the SMU list.
8. The SMU order can be changed by using UP/DOWN button.
9. Set the SMU names, mode and function as follow.

Unit V name I Name Mode Function
SMU1 Vs Is V CONST
SMU2 VDS ID VPULSE CONST
SMU3 Vsub Isub V CONST
SMU4 VGS IG V VAR1

Default setup
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Set SMU Output Parameters (VAR1,CONST) and Display setup
To set X-Y scale:

Set X axis:
1. Click on the maximum X scale value.

Note: The focus area to detect your touch is very narrow. Click exactly on the character area to 
pop up the scale input box.

2. Horizontal Max. input box pops up.
- Enter  5 V, then click X mark of the input box or press Enter key.

Note: Clicking other area cancels your input.
- Horizontal max. scale is changed to 5 V.

Set Y axis:
3. Click on the maximum Y scale value.
4. Vertical Max. input box pops up.

- Enter  2 mA, then click X mark of the input box or press Enter key.
- Vertical max. scale is changed to 2 mA.

Set X-Y min. value:
Repeat the same steps shown above for min. scale, too.

To set VAR1:
5. Set VAR1 parameters:

a. Click down arrow icon      .  
VAR1 field expands.

b. Set the following parameters:

Tips: To scroll the measurement parameter input field:
c. By focusing (pointing) the parameter input field, "Drag to scroll" sign appears (see #d).
e. By dragging the bar, the mouse cursor changed to "hand" mark, and you can scroll the bar, and can see 

the hidden part of the bar.

Mode Start Stop NOS Interlacing Compliance Pwr comp Dual Polarity
LIN-SGL 0 2 101 1 100 uA OFF OFF
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Set SMU Output Parameters (VAR1,CONST) and Display setup (Cont.)
To set CONST and Meas. Time:

6. Set CONST parameters
f. Change the CONST field to set each SMU parameters by changing the SMU Unit field.
g. Set the following parameters to each SMUs. 

Note:
h. Drain SMU 2 is a pulsed source, and the input field must be expanded      to show all the 

input parameters. 
Scroll up the Menu bar by dragging the bar as illustrated in previous slide.

7. Set Meas. Time (Integ Time) and Pulse Period:
i. Set following parameters.

Unit Source Compliance Pulse Peak Pulse Base Pulse Delay Pulse Width
SMU1 0 V 100 mA - - - -
SMU2 - 10 mA 100 mV 0 V 0 s 500 us
SMU3 0 V 100 uA - - - -

Meas. Time Pulse Period
10u~450us AUTO
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Start Id-Vg Tracer & Rotate Knob to change the parameters
To set Demo MOSFET:
Refer to the demo device setup section of Lab 1 module.

To start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.

This is especially important when the measurement covers a wide current range from sub-
pA to a mA range. 

2. Click Repeat button.
Repeat measurement starts.

3. The Id-Vg real time sweep trace appears as shown in above slide.
4. Toggle LIN/LOG vertical scale button changes the Y scale to LOG/LIN.

Note: 
- The min./max. scale changes to default value when you change the scale.
- You can change the scale by using the mouse wheel. 

Try: 1. Click the min. or max. scale value. Then the scale input window opens. 
2. Rotate the mouse wheel. The scale is changed continuously.

5. Click Stop button.
6. Change the Setup Name to "Id-VGS TT" and save it to My Favorite. 
7. Click Repeat button to start a repeat measurement.
8. Highlight the VAR1 Stop entry field and leave it in active status.
9. Rotate the rotary knob to change sweep range.

How is the trace changed?
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Set Reference Trace, Stop Condition
You can set a reference traces and stop condition.
• Reference trace is useful when you compare the device characteristics between the devices or 

changes, for example, a drift by self heating.
• Stop condition stops the measurement to catch the data surely when the measurement reaches 

the user defined stop condition area. 
To set Reference traces & Stop Condition:

Follow the next steps to set the function.
1. Set the Id-Vg graph display in the following condition:
• Vg = 2 V
• Y-Max. = 2 mA, X-Max = 5V

2. Repeat measurement
• Press Repeat measurement button.
• Click "Stop" voltage input field to activate the change/control

3. Set Reference Trace:
• Click Camera button to set the current trace as the reference trace.

4. The trace changes to green by overlapping the yellow current and blue reference traces.
5. Rotate the knob by activating the Stop voltage under the repeat measurement condition.
6. Left turn decrease the gate voltage, and can be seen the relation of the reference and current 

traces.
7. Right turn shows the opposite direction of above step.
8. Click Stop condition setup button. The traffic signal icon changes to Yellow, and the stop 

condition (abnormal area to stop sweep) can be set.
9. Point and drag to specify the abnormal stop region: Specify 0~5V and above 1.2 mA as abnormal.
10.Activating the Stop voltage and right turn the rotary knob until the measurement trace goes into 

the abnormal stop region.
11.The sweep will be aborted and stops just after the sweep enters the abnormal region.
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Recall previous Id-Vg measurement traces
You can automatically record your measurement in real time manner and recall them later for review.
This functionality is useful when your device shows an abnormal transient behavior which may be not 
possible to reproduce easily.
By default, a limited number of measurement traces are automatically recorded and kept in the 
memory. Therefore, you can go back to a certain point to review your intermediate measurement 
result.
By saving the trace while they are in the memory, you can recall them later even if you power off the 
B1500A.
In this lab, we`ll recall the knob sweep traces which were automatically recorded in previous lab.

To Use the Replay Function:
1. To open the Replay Function window:

- Click Replay Traces button.
2. To replay traces:

To display recorded lines: Use the slide bar or the arrow buttons (<<, <, >, >>).
Long-clicking the << or >> button changes the trace sequentially.

Replay Function Parameters:
• Replay Interval: Set the time interval of the long-click operation of the << and >> buttons. 
• Maximum Records:  Set the maximum record count. 

After the record number reaches this value, the record is deleted from the 
oldest one.

• Recording Interval: Set the time interval of the automatic trace record operation.
Note:

This function returns only the measurement data (x-Y data), and you have to set proper Axis 
parameters (scale, V or I).
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Extract Vth using regression line function
Tracer Test mode supports Marker, Tangent line and Regression line analysis functionalities.
We`ll demonstrate regression line for extracting Vth of the MOSFET.

To draw Regression Line:
Follow next steps to draw a regression line for extracting Vth.
1. Click Regression line icon.

Marker appears on the first point of the measurement data.
2. Select the data area to calculate the regression line.

Point and drag the data area to specify the data. The data surrounded by the area is used for 
calculation.

3. Regression line is drawn.
Note: If there are more than one data line, click the data line to draw a regression line.

4. Line parameters are shown on the upper right corner of the display.
In this example, the X-intercept is 1.031 V.

If we compare the result with the Id-Vd Vth classic test, then,
we must subtract 50 mV (= Vd/2) according to the definition of the classic test.
1.031V - 50 mV = 981 mV, that is very close to the 990 mV of the Lab 3 result.  

Note: The analyzed result is not saved in the result data. Save the result by saving in the graphic 
format.
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Convert the test setup to Classic Test mode test setup 
You have to remember the following tips when recalling the Tracer Test mode setup or result data.
This is because the Tracer Test mode data set is designed as a subset of Classic Test mode.
Because of this, there are a few rules to go and back the Tracer Test mode and Classic Test mode 
with the Tracer Test mode data.

Recall My Favorite Setup:
You have two options to recall the Tracer Test mode setup data to EasyEXPERT as shown next.

To Open in Tracer Test mode: (See #1 - upper side of the above slide)
• Simply recalls the Tracer Mode Test setup file of My Favorite in Tracer Test mode.
• The setup opens in Tracer Test mode.
To Open in Classic Test mode: (See #2 - lower side of the above slide)
• Simply recalls the Tracer Mode Test setup file of My Favorite in Classic Test mode.
• The setup opens in Classic Test mode.
To Convert the Tracer Test mode setup to the Classic Test mode setup
• The Tracer Test mode setup is recalled in Multi Channel I/V Sweep mode classic test , 

and it is already a Classic Test mode definition. 
• Simply change the name and save it to My Favorite Setup area.
Note:

This is the easiest way to setup a Multi Cannel I/V mode classic test definition because;
1. Tracer Test mode has test setup example.
2. Tracer Test mode creates detail setup by filling in the measurement parameter. 
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Tips: Knob Sweep can be used for any measurement parameters
You can change any measurement parameters by using the rotary knob.
We demonstrate that Vd can be continuously changed by knob sweep capability.

To Change Vd by Knob Sweep:
Follow the next steps to sweep Iv-Vg by changing the Vd continuously.
1. - Set the Y axis max. to 5 mA.

- Set 2 V in the Stop V input field. 
- Click Repeat measurement button.
- Activate Stop V parameter by clicking the input parameter field.

2. Rotate knob to sweep Vg to 2.5 V. 
3. Id-Vg trace is displayed.
4. Click Camera button to set this as a reference trace.
5. Activate Pulse Peak input of CONST parameter.

Note: Set SMU2 - Vd in CONST parameter area.
6. Rotate knob to increase Vd (SMU Pulse Peak).
7. The Pulsed Id-Vg trace increases as shown in above slide (check the direction of red doted 

arrow).

As shown in this lab, knob sweep can be used for any numerical input field to change parameters 
while in sweep measurement.
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Tips: Graph Setup and Option Tools
Tracer Test mode employs graph analysis tools. Some nice functions are shown n next:
• X or Y axis setup: 

X or Y direction forward or reverse
Variables for X-Y plot
Graph scale linear or log
Plot polarity positive, negative, or both.

• Line/Dot: Used to switch line or dots of trace. See “Line/Dot” page.
• Set stop condition area.
• Replay traces: Opens/closes the dialog box used for managing the record and replay of traces. 
• Capture a reference trace: Used to capture the trace as the reference trace. 
• Select reference traces: Opens/closes the dialog box used for managing the reference traces. 
• Select tracking traces: Opens/closes the dialog box used for managing the tracking traces. 
• Marker: Enables/disables the marker.
• Tangent line: Enables the marker and enables/disables the tangent line.
• Regression line: Enables the marker and enables/disables the regression line.
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Tips: Select Reference Traces
Reference trace means the trace set as the reference by using the Capture a reference trace 
(camera) button as shown in step 3 of the previous page demo..  
You can capture up to 10 reference traces.

To perform operations to the selected trace:
Following operations are possible.
• Show/hide selected trace
• Inversion of the selected trace
• Erase  the selected trace
• Open/Save a selected trace 

Additional Information: Select Tracking Traces
Append measurement generates the "Tracking traces".
The "Select tracking traces" button is available to select/delete measurement result which 
contains at least two traces by the append measurement.  
Tracking trace means each trace of this measurement result.
• You can activate one of append measurement traces for analysis.
• You can erase a selected trace.   
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Tips: SMU Pulse
SMUs can be pulsed for precise force/measure timing, or to reduce heating of the device when 
forcing high currents.

Pulse width and period is kept as specified. The available values are as follows.
- Pulse width HR/MP/HP/HVSMU: 500 us to 2 s, 2 us resolution
- Pulse period 5 ms to 5 s, 100 us resolution

Multiple pulsed channels are available for Tracer Test and Multi Channel I/V Sweep Classic Test.

The measurement unit performs measurement by using the compliance range. It is the minimum 
range which covers the Compliance value. The Compliance value should be the expected maximum 
measurement value or greater.
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Lab 4: Summary

We learned the topics/items listed in above slide through creating and measuring Id-Vg 
Tracer Test.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.

Check "Turning off  the B1500A" page in the final part of the Lab 1 session for detail.
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Lab 5: CV Measurement Using SCUU in Classic Test Mode

Lab 5 covers following topics.
1. IV/CV Measurement Dilemma in traditional approach
2. SCUU Solves the Dilemma of IV/CV measurement
3. CV Demo Test Setup.

- The CV Demo approach.
- C-Vg Sweep classic test setup.
- Measurement with automatic marker analysis.

4. 1 MHz and 100 kHz Measurements.
5. CMU Open Calibration.

6. Summary
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IV/CV Measurement Dilemma in traditional approach
There is a dilemma in traditional IV/CV approach in semiconductor application.
Semiconductor application typically requires the CV and IV measurement in a single test 
connection to the device, when measuring on a wafer.
The prober manipulator usually uses triax connector. (see #1 in the slide)
The CV measurement system uses coax BNC cable (see #2)
The IV measurement system (SMU) uses triax cable (see #3)
The DC path requires triax cabling system for assuring low current precision measurement.

Therefore, there are many questions to connect from the CV system to the manipulator, such as;
• Which CV cabling to use?  i.e. 2 or 4 terminal pair (see #5) connection?
• Use coaxial cable? (see #2), or triaxial cable (see #3)?

Where to convert from Coax to Triax?
• How to deal with AC and DC Guard (see #6 & #7)?
• How to make capacitance compensation?
• Is CV return path necessary?  If yes, how? (see #8)

Note: Return path is to connect between the AC guard of Hi and Lo at the cable end for stable 
CV measurement.

This Lab answers for such user`s dilemma or questions.

Note: 
The above B1500A configuration can be considered as two independent  SMU system and CV 
measurement system though they are installed in one mainframe.
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SCUU Solves the Dilemma of IV/CV measurement
SMU CMU Unify Unit (SCUU) solves all the problems relating the IV/CV measurement setup.

1. SCUU (see #1) solves Triax & Coax switching problem.
SCUU switches between the I/V path (see #2) and the C/V path (see #3) by satisfying both the 
IV and CV requirement.
A specially designed low leakage relay (see #4) keeps the I/V and CV measurement accuracy.

2.  The Guard Switch Unit (GSWU -see #5) solves AC guard problem.
GSWU closes in the C/V measurements and opens while I/V measurements are performed.
These switch operation is automatically done when you run the software, and the cable length 
between the CMU and the SCUU is automatically detected and capacitance error compensation 
is also automatically performed.

3. Only Triax cable is used for connecting to the test device for both IV and CV 
measurement. (see #6)
The triaxial cable is used between the SCUU and the wafer prober manipulator or Test Fixture. 

This is a solution that you cannot add any mistake for both the I/V and C/V test system setup.
The I/V and C/V measurement dilemma is disappeared now with SCUU.
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SCUU and GSWU Connection on a Wafer
1. SCUU is extended from the B1500A to the probe station. (see #1)
2. The triaxial cable is connected between SCUU and prober manipulator. (see #2)
3. GSWU is hooked on the guard of the probe pin to satisfy both the DC guard for SMU and AC 

guard for CMU. (see #3)

Most customers have a very hard time switching between CV and IV measurements (many 
customers actually devote separate probe stations to CV and IV just to avoid having to change 
cables).  
In addition, great care has to be taken when cabling to a capacitance meter to insure that all of the 
capacitance measurements are properly compensated.  The SCUU removes all of these worries and 
makes connection simple and easy.  
In addition, the B1500A software automatically takes care of the multiplexing based upon the type 
of algorithm selected from the front panel.
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Overview of the Lab setup:
This test setup connects the CMH to the Gate, and CML is connected to the Subs.
SMUs are connected to the Drain and Source to force 0V.
In this configuration, the drain and source channel is created after the gate voltage exceed Vth,  
and the CV curve is distorted because the AC signal is bypassed to the drain and source from 
the bulk where the CV current is measured.
We`ll use Classic Test mode for getting the maximum flexibility in the setup.
Note:
• The demo SD214 Nch MOSFET maybe not suitable for demonstrating the CV measurement, 

but we  use this device for CV demonstration .
• The MFCMU outputs the measurement AC signal and the DC bias voltage from the CH (Hc 

and Hp pair) terminal.
The capacitance measurement AC current is measured by the CL (Lc and Lp pair) side.

CV Measurement: Tips:
• CMH, CML, SMU (as Guard) connection in CV measurement changes depending on which 

capacitance to measure.
In case to connect the Drain and Source to the capacitance meter, using switching matrix is 
convenient.
• Typically CV measurement is made applying the DC bias to the bulk side because it is more 

noise immune in the case of the measurement using the automatic wafer prober.
• This time, since the drain and source is connected to the SMU cable and it is not possible to 

change connection in the case of the N1295A Test Fixture, we choose to sweep gate and set 
the other terminal to 0 V.
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To Select Classic Test Mode and C/V Sweep Classic Test

Follow the next steps to open the C/V Sweep classic test:
1. Click Classic Test tab

Classic Test execution mode icon appears.
2. Click C/V Sweep mode icon.

Select button appears.
3. Click Select button.

C/V Sweep classic test setup editor with Channel Definition page opens.
(See next page.)
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Define Source/Measure Channels
Click the Channel Setup tab to display the channel definition screen. 

To set Channel Definition:
Follow the next steps to define the Channel Setup page.
1. Enter the Setup Name for the test setup to be defined on the setup editor.

Enter "C-Vg Sweep"
2. List SMUs used for source output, and set the following parameters.

Unit: V Name: I name: Mode: Function:
SMU 1 Vs Is V CONST
SMU 2 Vd Id V CONST

3. List CMUs used for source output, and set the following parameters.
Unit: V Name: I name: Mode: Function:
CMU 1 Vg_sub -- -- VAR1
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Define Measurement Parameters
Click the Measurement Setup tab to display the measurement parameter definition screen. 

To Set Measurement Setup page:
Follow the next steps to define the Channel Setup page.
1. C-V (VAR1) setup:
Enter the following parameters:
• Start: -5V
• Stop: 5 V
• Step: 100 mV
• Other parameters

We`ll uses the default setup as shown in the slide.
2. Measurement Frequency setup:
• Frequency: 1 MHz

Note: If you add frequency, then the CV measurement repeats with that frequency.
3. AC Level setup:
• AC Level: 30 mV

4. Integration Time setup:
• Mode: AUTO

5. Constants setup:
• SMU 1: Source=0V, Compliance=1 mA
• SMU 2: Source=0V, Compliance=1 mA
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Setup Automatic Marker Analysis
Click the Auto Analysis Setup tab to display the auto analysis setup screen.
The auto analysis capability allows you to display/move the marker/line on the data graph 
automatically after measurement.
The above example displays marker at Vg=0 V point.

To Set Marker Automatically on a specified measurement point after the 
measurement:
Marker:  This area sets the marker automatically displayed and moved to the specified position 

after the measurement.  

Follow the next steps:
1. Check Enable box to enable the marker.
2. Enter to the Condition field:

Vg_sub=0
Note:

For Condition, enter a variable name and a condition expression to specify where you want 
the marker to display.
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Define Data Display Parameters
Click the Display Setup tab to display the data display setup screen. 
• The X-Y Graph area is used to set the X axis and Y axis of the X-Y Graph Plot area in the Data 

Display window.
• The List Display area selects the variables to be listed in the List Display area of the Data Display 

window.
• The Parameters area selects the variables to be listed in the Parameters area of the Data Display 

window.
1. To Set X-Y Graph:
Follow the next steps to define the X-Y Graph.
1. Click and check the box  of X: axis input line

The X-axis input field becomes active.
• Select:  Name= Vg_sub, Scale= Linear
• Enter: Min=-5 V, Max=5 V

2. Click Add button.
Y1 scale input field opens.
• Select:  Name= C, Scale= Linear
• Enter: Min=0 F, Max=3 pF

2. To Set List Display:
Follow the next steps to define the List display.
1. Click Add button. 

List parameter line appears.
• Select:  Vg_sub

2. Click Add button again. 
• Select:  C. 
• Repeat this process and select the following parameter to list:

Vs, Vd,  Freq 
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C-Vg Sweep Measurement
To Set Demo MOSFET
Refer to the demo device setup section of Lab 1 module.

To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.

This is especially important when the measurement covers a wide current range from sub-
pA to a mA range. 

2. Note:
Before the measurement make sure the "Auto Record" function is set to ON status.

3. If there is no check on the "Record Test Result Data Automatically", then check it.
The Status indicator should show "Auto Record ON".

4. Click Single Measure button.
Measurement starts.

5. The C-Vg Sweep data display window opens.
Note that maker is automatically shown up as specified in the setup.
Rotate rotary knob and check the data in Marker field.

6. Just Click "OK" to save the initial data.
If you want to save the data after you move the mouse, you have to do "File -> Update Test  
Result".
In the case where "Record Test Result Automatically" is unchecked, then you move the 
marker -> save the data will save the updated data.

Note: If you Click "Delete" button, the data is saved with "Delete" status.

2-5-11



Let`s Measure both 1 MHz and 100 kHz
We`ll add 100 kHz measurement frequency.
Follow the next steps for adding 100 kHz and to make measurement.

1. Open Measurement Setup page.
2. In the Frequency List: are, click Add.

New frequency list line appears.
3. Enter 100 kHz or select from the pull down list, or
4. Choose from the frequency list.
5. Change Setup name to "C-Vg Sweep 2
6. Save to My Favorite Demo group
7. Press Single measurement button. 
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1 MHz and 100 kHz CV Measurement Data 
Both the 1 MHz and 100 kHz data graph is shown up.
There is a little difference in higher capacitance (or lower Vg) area.

To Explore the data:
1. Rotate Marker:

Rotate rotary knob to explore the data
You can read out the data in marker readout field.

2. Skip Marker:
You can skip VAR2 step (Frequency is VAR2 in this case) by clicking Marker Skip icon
You can see the Freq data in List Display changes to 100 kHz.
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CV Setup Tips: CV Calibration
If you change the CV measurement hardware setup, performing the CV calibration is important for 
accurate CV measurement.

How to calibrate CMU:
How to calibrate CMU is shown in above slide.
We`ll try open compensation in this lab.
Follow the next steps to calibrate CMU.

1.Click Calibration button.
Calibration window opens.

2.Open CMU Calibration page by clicking CMU Calibration tab.
3.Click Measure button of Open correction.
4.Open Correction dialog box opens.

Disconnect the MOSFET from the Test Fixture and
Press OK button.
Open calibration starts.

5.After the calibration finished, Open Correction is checked.
6.Click Close to finish the Open collection.

Lab: Measure MOSFET Again: Append Measurement
Let`s measure the MOSFET again.
This time we`ll use append measurement to compare the result.

1. Click Append Measure
2. Is there any difference in the two traces, before and after the calibration?

Note: If there is no change, it means your measurement system has been properly 
calibrated.
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Lab 5: Summary

We learned the topics/items listed in above slide through measuring C-Vg sweep classic 
test.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 6: 100 us Sampling Measurement

Lab 6 covers following topics.
1. Overview of sampling measurement
2. The relation between setting and actual interval
3. Creating 100 us sampling measurement
4. Summary
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B1500 supports the sampling measurement, and there’s some operation mode, 
and this figure shows the timing chart for SIMULTANEOUS source mode and 
interval < 2 ms.

With the SIMULTANEOUS output sequence, the source channels start to force the 
Base value simultaneously. After the last sampling measurement, the source 
channels stop output simultaneously.

With the SEQUENTIAL output sequence, the source channels start to force the 
Source value sequentially. The order of source output is defined in the Channel 
Setup.  Top of the channels on the setup screen starts output first.  And the 
following channels start output sequentially.  After the measurement, the source 
channels stop output sequentially in the opposite order.

For the measurement channels which use the high resolution A/D converter, the 
order of measurement is defined in the SMU Range Setup.  Top of the channels on 
the setup screen starts measurement first.  And the following channels start 
measurement sequentially.  For the measurement channels which use the high 
speed ADC, the channels start measurement simultaneously.

See the next page the relation between setting and actual interval.
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The operation changes by 2 ms for a interval setting.

Interval < 2 ms prioritizes time, and interval is kept as specified. Instead, HSADC 
and fixed ranging is automatically set to keep the sampling interval. 

Interval  >= 2ms prioritizes accuracy, and interval is automatically set longer if the 
measurement time and some extra for range changing etc. takes longer than 
interval. 
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Set parameters on I/V-t Sampling

Follow the next steps to enter the necessary parameters;
1. Click “Classis Test" mode.
2. Select I/V-t Sampling, then press “Select”.
3. Enter the Setup Name, For example,  “100us Sampling”
4. Click the Channel Setup tab to display the channel definition screen. 
5. Press “Add SMU” to be SMU1, SMU2, SMU3 and SMU4 listed.
6. Enter the following parameters to selected SMUs. 

• Unit: SMU name or number.  The GNDU (ground unit) can be set instead of a SMU.
• V Name: Variable name for the voltage measurement or source data
• I Name: Variable name for the current measurement or source data
• Mode: Source output mode, V (voltage), I (current) or COMMON (ground)
V Name and I Name are used to specify the parameters displayed on the Data Display window.  
The display parameters are selected on the Display Setup tab screen. 
Set the following parameters:

Unit V Name I Name Mode
SMU1 Vs Is V
SMU2 Vd Id V
SMU3 Vsub Isub V
SMU4 Vg Ig V
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Define Measurement Parameters

7. Click the Measurement Setup tab to display the measurement parameter definition screen.  
The Measurement Setup tab screen is used to set the source output value parameters. 

8. Set Sampling Parameters
• Linear/Log: Linear sampling or Log sampling
• Interval: Interval of the sampling, in seconds
• No of Samples: Number of samples
• Total Sampling Time: This field just displays the total sampling time. It does not include the 

hold time.
• Output Sequence: Source output sequence. SIMULTANEOUS or SEQUENTIAL.
• Hold Time: Time since the Source value output until the first sampling point, in seconds.
• Base Hold Time: Hold time of the Base value output until the Source value output, in seconds.
Enter the following parameters:

9. Set Sampling Parameters
• Base: Base value, in V or A.
• Source: Source value, in V or A.
• Compliance: Compliance value, in A or V.
Enter the following parameters:

Linear/Log Interval No of Samples Output Sequence Hold Time Base Hold Time
Linear 100 us 21 SIMULTENEOUS -1 ms 0 s

Unit V Name I Name Mode Base Source Compliance
SMU1 Vs Is V 0 V 0 V 100mA
SMU2 Vd Id V 0 V 100 mV 100 mA
SMU3 Vsub Isub V 0 V 0 V 100 mA
SMU4 Vg Ig V 3.3 V 1.8 V 100 mA
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Define Advanced Setup

10. Press the Advanced to open the Advanced Setup window
11. Set Channel Settings.
• Unit: SMU used for the measurement
• VName: Variable name of voltage output or measurement data
• IName: Variable name of current output or measurement data
• Series R: Series resistor NONE or 1MOHM
• SMU Filter: SMU filter ON or OFF.
Set the following parameters:

12. Set After Measurement Settings
• Bias Hold after Measurement : Bias hold function ON or OFF.
• Output Value after Measurement : SOURCE or BASE
Set the following parameters:

Unit V Name I Name Series R SMU Filter
SMU1 Vs Is NONE OFF
SMU2 Vd Id NONE OFF
SMU3 Vsub Isub NONE OFF
SMU4 Vg Ig NONE OFF

Bias Hold after Measurement ON
Output Value after Measurement BASE

2-6-6



Display Setup

13. Click the Display Setup tab to display the data display setup screen. 
14. Set X-Y Graph

a. Click and check the box of X: axis input line. The X-axis input field becomes active.
b. Click Add button for adding an additional line for Y1.
c. Enter the following parameters:

15. Set List Display
a. Click Add button. 

List parameter line appears, then select Time.
b. Repeat Add and Select to Id, Vd, Vg listed. 

Axis Name Sharing Scale Min Max
X Time (None) Linear -1 ms 1 ms
Y1 Id (None) Linear -1 mA 1 mA
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To Set Demo MOSFET
Connect the demo MOSFET before the test.
Refer to the demo device setup section of Lab 1 module.

To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.
2. Click Single Measure button. Measurement starts.

The 100 us Sampling Display window appears.
3. Click Marker On/Off button to enable the marker.
4. Click Marker Search button.
5. Enter X = 100 u
6. Press OK
7. Check the List Display.

Time Stamp shows 100 us interval.
Vd and Vg changes from Base to Source at Time = 0 s.
Measured Id changes at Time = 0 s with the changes in the bias condition. 
‘X’ status means oscillation. ‘X’ at Time = 0s is normal behavior; it is due to the voltage 
change from Base to Source.
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Lab 6:Summary

We learned the topics/items listed in above slide through measuring 100 us 
sampling measurement.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 7: Quick Test

Lab 7 covers following topics.
1. What is Quick Test?
2. How to execute Quick Test.
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What is Quick Test?
In Quick Test mode, you can execute a series of test that is included in one group of "My Favorite 
Setup".
If quick test is combined with repeat measurement and semi-automatic prober, you can perform full 
automation wafer test including sub-die move.

To Perform a Quick Test
• Quick Test List:
- If you click "Quick Test" mode, then the same setup included in the current My Favorite 
Setup group opens.

- Actually My Favorite Setup group in the Application Test, Classic Test and Tracer Test mode 
is exactly the same as the Quick Test setup.  

- They are transparent and any changes made in one mode appear to Quick Test setup, or vise 
versa.

• Quick Test Control:
You have the following setup option to execute each test in the quick test list:
- Execution ON/OFF
- Data record ON/OFF for each test.
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To Perform Quick Test
Follow next step to execute Quick test.

1. Click Quick Test tab.
2. Select the Preset Group, "Demo".
3. Set the execution ON/OFF and the data record ON/OFF for each test.

In the example; Id-VD Demo and Vth gmMax Demo are set.
4. Connect DUT, and click the Single button.  The B1500 starts the selected tests from top to 

bottom in the list.
After the measurement, the test result data is displayed on the Data Display window.  And 
the Test Result Editor is displayed on the lower left area of the B1500 screen if the Auto 
Record function or the Auto Export function is set to ON.  
Check the status indicator at the bottom of the screen.

5. Analyze the measurement result data.

Note:
1.  The softkeys placed right side of the LCD are used to trigger a single measurement of the 

associated test.
2.  The quick test execution setup status that is execution status ON/OFF and the data 

record ON/OFF is automatically saved as MY Favorite Setup Group status, and you can 
execute the group without re-editing the execution status.
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Lab 7: Summary

We learned the topics/items listed in above slide through performing Quick 
Test

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 8: Reporting
This lab handles the topics relating the reporting.
When you make a repot,  such activity as analyzing data, converting data and transferring data 
between your application software,  is necessary.

Lab 8 covers following topics.
1. Desktop EasyEXPERT
2. Display/Recall Data
3. Copy Graph
4. Copy List data
5. Export/Import Results Data
6. Export/Import My Favorite Preset group
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Option: Use of Desktop EasyEXPERT
Using Desktop EasyEXPERT for reporting purpose is a good alternative idea.
• Because it is off-line, you can access to your measurement data at anytime if once your 

measurement data is exported from the B1500A and imported to your Desktop EasyEXPERT.
• Since you can use your PC, you can use your familiar application for farther analyzing the 

measurement data and creating your report.
• If your desktop area is large, it surely improves the data handling inside Desktop EasyEXPERT and 

your applications.

Note: This lab does not require Desktop EasyEXPERT.
If to use Desktop EasyEXPERT, refer Appendix A.

Note: On-line use
Desktop EasyEXPERT can be used on line as exactly the same way as EasyEXPERT on the 
B1500A if your PC and the B1500A is connected via GPIB. Therefore you can access to the 
B1500A measurement recourses without exporting your test library which is developed on your 
off-line PC or new setups. The measurement data is automatically saved on your Desktop 
EasyEXPERT, and there is no need to expert result data from the B1500A and importing to your 
PC.
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Recall or Re-Display Result Test Data For Analysis
The Test results saved in the List data area of EasyEXPERT can be recalled or displayed in any 
time.
The data recalling capability is useful for  analyzing your data and making a report after all the data 
is taken or after you move the data to Desktop EasyEXPERT.
There are following two ways to display the test result.

1. Display Data: Displays only the test data in data display window.
You can make analysis on the displayed data.

2. Recall: Recalls both the data display window and the setup data.
Recalling data is useful when you need to check the measurement setup, or
want to make a measurement again after reviewing your data.

To Recall/Display Data:
1. Right click on the data line, or 

select a line -> click Results bar opens the function menu.
2. Click Display Data or Recall.
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To Copy Graph Plot
The above slide shows an example of the copy and paste operation.
The graph displayed on the data display window can by copied to the clipboard.
You can paste the graphic image to other Windows application, for example, a word processing 
software. 

To Copy Graph:
In the above example, the graph image is pasted to the WordPad.

1. Open the data display window to copy.
2. From the file menu, select the "Edit > Copy Graph menu" on the Data Display window.
3. Open WordPad (or other application)

- Select the Edit > Paste menu on the WordPad.
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To Copy List Data
The above slide shows an example of the copy and paste operation.
The data list shown on the data display window can be copied to the clipboard.
You can paste the data to other Windows application, for example, Window Notepad software. 

To Copy List Data:
In the above example, the data list is pasted to the Notepad.

1. Open the data display window to copy.
2. From the file menu, select the "Edit > Copy List" menu on the Data Display window.
3. Open Notepad (or other application)

- Select the Edit > Paste menu on the Notepad.

Note: The copied data is the same format as displayed in the List display area.
If you past the data to a spreadsheet for analysis, you may need to change the number 
format in List area.
(See next page.)

Note: List
As same as the Copy List function, the Copy Parameter function is used to copy the data in 
the Parameter area.
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To Copy List Data in a Different Format to Use with Spread Sheet Application
There are several formats in displaying the List Display.
The dialog box shown in above slide is used to set the data display format in the List Display area.

To Open the List Display Properties Dialog box:
1. Click the "Properties..." button in the List Display area or
2. Select "Edit > List Display Properties..." menu of the Data Display window. 
3. List Display Properties box opens.
Display area: 
Check the following check box to add the data status or the physical unit to data. Unchecking 
the box removes it.
• Data Status: Adds or removes the status code before data.
• Physical Unit: Adds or removes the physical unit after data.
Number Format area: 
Selects the data display format from the following formats.
• Engineering Format (with Unit Prefix):

Data display with arithmetic point, SI prefix, and unit.
Example: -1.2345 mA

• Scientific Notation:
Data display with arithmetic point, exponential part 
(E, +/- sign, and three-digit number), and unit.
Example: -1.23456789012345E-003 A

For Spread sheet calculation,  use these properties:
(Check only "Scientific Notation")
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Export Measurement Data Record
The measurement data can be exported to the external file in a format that the other application can 
be used.

To Export the Test Record:
To export the test result record, follow the next steps.
1. Specify the data records to export.
2. Click Result button and display the function menu.
3. Select the "Transport Data > Export As xxxx" from the menu list.

xxx denotes the available format.
Windows Explore opens.

4. Specify the file name and the directory to save the data.
Note: Multiple test records can be exported in one file by using "Transport Data > Folder Export…" 

menu.
There are the following five formats to export the test record:
• (Compressed) Test Result file: Used to transfer between EasyEXPERT.
• CSV file: Comma delimited text file. 
• XML spreadsheet file: A XML file created by using the specified XML style sheet.
• My Format: Delete some part of unnecessary data by using a filter file.
• Text File format: Export only the necessary data by using a GUI based filter.

Export File Suggestion:
There are many export file format and filter combination. The filter is used to extract the necessary 
data element from the EasyEXPERT internal database.
The  following format is suggested for easy-of-use and satisfactory result for first step users.
• "Export as Compressed Test Result ...": Used to transfer between EasyEXPERT.
• "Export as Text File...": Used to transfer data between the Windows application.

Make sure to set the "Text File Export Setting ..." when using this format.
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Import Test Record to EasyEXPERT
The measurement data can be imported to the EasyEXPERT.
This operation would be useful when you move the data to Desktop EasyEXPERT for off-line 
analysis and creating a report.

Note:
Only the file exported as "Test Result" or "Compressed Test Result" format can be imported.

To Import the Test Record:
To import the test result record, follow the next steps.
1. Click Result button and display the function menu.
2. Select the "Transport Data > Import..." from the menu list.

The Test Result Import dialog box is opened.
3. Select the file to import.
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Export/Import My Favorite Preset group
You can export/import your preset group.
This operation would be useful when you move the preset group between the B1500A and Desktop 
EasyEXPERT.

To Export:
To export the present preset group, follow the next steps.
1. Click the My Favorite Setup button
2. Click Preset group
3. Select "Export This Preset Group...", and specify the folder and the name of the preset group 

to export. 

To Import:
To import the preset group, follow the next steps.
1. Click the My Favorite Setup button
2. Click Preset group
3. Select "Import Preset Group...", and specify the preset group to import. 
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Lab 8: Summary

We learned the topics/items listed in above slide.

To Turn of the B1500A:
If this is today`s final demo work on B1500A, 
take of the demo device from the test fixture
and then turn off the B1500A.
Check "Turning off  the B1500A" page in the final part of the Lab 1 session for 
detail.
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Lab 9: Ultra Low Current Measurement using ASU

Lab 9 covers following topics.

1. What is ASU?
2. ASU configuration.
3. ASU/SMU zero cancel calibration
4. Id-Vg Sub-threshold Ultra-Low Current Measurement
5. Low current measurement tips
6. Summary
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What is ASU (E5288A Atto sense/Switch unit)

ASU is a extender box which extends the MPSMU(B1511B) and the HRSMU output current range 
to 100 aA.
It is connected to MPSMU/HRSMU with the triax cable and the control cable (see #1 in the slide).
It also has the channel switch capability for capacitance meter or PGU (see #2). 
Therefore, ultra low current SMU connection and CMU/PGU connection can be switched without 
changing the cable connection or using a switching matrix. 

Now ASU is supported by the new MPSMU (B1511B), and they complements the current ranges 
effectively without overlapping their built-in current ranges.
This is shown in the next slide.
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Low current measurement capability of SMUs

The table in the slide shows the available current ranges of B1500A SMUs including ASU.
1.ASU provides three current ranges from 1pA to 100 pA, and the higher ranges from 1 nA are 
provided by HRSMU or MPSMU.
You can measure sub-100 a level current measurement by using the 1 pA range of ASU as shown 
in #5 Id-Vg curve.
2.HRSMU provides 10 pA range to 100 mA range.
As #6 Id-Vg curve shows, HRSMU can be typically used for sub-fA level measurement.
3.MPSMU provides 1 nA to 100 mA range.
As #7 Id-Vg curve indicates, MPSMU can  be used for applications that requires about 10 fA 
current resolution.
But, you can extend the lower current ranges effectively using ASU.
4.HPSMU provides 1 nA to 1A for higher power applications.
Lower current performance is the same as MPSMU.

Note:
There’s no difference in current measurement performance between ASU+HRSMU and 
ASU+MPSMU.
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Required Accessories to Use ASU

Following items shown in the slide are necessary to use ASU.
• E5288A Atto Sense and Switch Unit
• ASU input cable:

- 16493M Triax and D-sub cable for ASU (Input)
- 16494A Triax Cable 

• ASU output cable:
• For on wafer measurement:

Connect directly to the manipulator with a low noise and  short triax cable.
• For packaged device:

- Use a short triax cable directly to the test fixture.
- In this lab: use 1.5 m triax cable.
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ASU Connection with the N1295A Test Fixture
Turn off the B1500A power when configuring ASU!

Step 1. ASU connection to B1500A SMU:
Connect the B1500A SMU output and the ASU input terminals by following the steps 
shown in the slide.

1. Connect the SMU2 HRSMU D-sub output to the ASU D-sub Input using the D-sub 
cable of 16493M ASU cable set.
Fit the D-sub connector using the screws on both side of the connector.

2. Connect the SMU2 HRSMU Force output to the ASU SMU Input using the Triax cable 
of 16493M ASU cable set.

3. Connect the ASU Force output to the N1295A  Input 2.

Step 2. connection between B1500A SMU output to N1295A Test Fixture:
Connect the B1500A SMU output and the N1295A input terminals using SMU cables.
Follow the next steps referring to the numbers shown in the slide

4. Connect the B1500A HRSMU 1 Force to the N1295A Input 1.
5. Connect the B1500A MP/HRSMU 3 Force to the N1295A Input 3.
6. Connect the B1500A MP/HRSMU 4 Force to the N1295A Input 4.
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Checking the ASU configuration

Check ASU configuration after the setup of ASU by following the next steps.
1. Turn on the power of the B1500A.

Then click Configuration icon.
2. Configuration window opens.
3. Click Modules tab.

Slot Configuration panel appears.
4. Check the ASU is configured as shown in the slide.
5. Reference information:

If you click, for example, on the Multi Channel I/V Sweep of Classic Test mode test, The 
HRSMU/ASU is expressed as SMU2:HR/AS.

2-9-6



SMU Zero Cancel

It is important to perform the "Zero Cancel" to the SMUs including the measurement cables and the fixture 
when the measurement requires very low current resolution.
B1500A can measure the total offset current including from the SMU to the fixture, and subtracts the offset 
values which are associated with each SMU ranges from the measurement value.
Therefore, the user can expect more accurate low current measurement results in low current applications.

To preform the SMU Zero Cancel:
Note: Warm up the B1500A for minimum 40 minutes, and then perform Self calibration before starting 
the zero cancel operation to achieve the accurate and stable measurement.
Follow the next steps by referring to the numbers shown in the slide.
1. Click Calibration icon.
2. Calibration window opens.
3. Click SMU Zero Cancel tabs. SMU Zero Cancel panel opens.
4. Click SMU2:HR/AS line to highlight the name and the ranges.

The integration Time field becomes active.
5. Enter Integration Time field: 16 PLC.  This is the PLC used for the Id-Vg measurement.
6. Click SMU2:HR/AS check box, and select SMU2:HR/AS as zero cancel SMU.
7. Click Measure button.
8. Offset Current Measurement instruction window pops up.

Follow the instruction, and continue the operation.
9. Click "OK" button starts the zero cancel calibration.

The "Measure" button changes to "Abort" while the zero offset measurement progresses.
This measurement takes a few minutes if it includes ASU for measuring one channel.

10. The offset currents for each current range are shown.
11. Click close.
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Checking the Zero Cancel Effect Using I/V-t Sampling
Let's check the zero cancel effect using the I/V-t sampling measurement with the open DUT condition.

To set up the I/V-t sampling:
Follow the next steps by referring to the numbers shown in the slide.

1. Click Classic Test mode tabs
2. Click on I/V-t Sampling Classic test icon.
3. I/V-t sampling – Channel Setup page opens.
4. Set the following channel setup.

5. Click on Measurement Setup page tabs.
6. Set the following parameters in the Sampling Parameter input fields.

7. Set the following parameters to Constants field for SMU2:HR/ASU:
- Source = 0 V
- Compliance = 100 mA

8. Click on the Range button. SMU Range Setup window opens.
9. Set the following parameter to SMU2:HR/ASU Range parameter:

- Range = 1 pA
10.Click on the ADC/Integ button. "A/D Converter & Integration Time Setup" window opens.
11.Set the following parameter to Integration Time field of "High Resolution ADC":

- Mode = PLC,  - Factor = 32,  - Auto Zero = OFF

Unit V Name I Name Mode
SMU1:HR Vs Is COMMON

SMU2:HR/AS Vd Id V
SMU3:HR Vg Ig COMMON
SMU4:MP Vsub Isub COMMON

Linear
/Log

Interval No of 
Samples

Output 
Sequence

Hold 
Time

Base Hold 
Time

LINEAR 1 s 31 SEQUENTIAL 1 s 0 s
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To set up the I/V-t sampling: Display Setup:
Follow the next steps by referring to the numbers shown in the slide.

1. Click on the Display Setup page tabs.
Display Setup page opens.

2. Set the following X-Y Graph parameters.

3. Set the following parameters for List Display items:
- Time
- Id
- Vd

4. Change the Setup Name to " I/V-t zero Sampling".
5. Click Save button to My Favorite Setups.
6. Make sure that there is no device in the test fixture.

Close the lid of the test fixture.
7. Click Single measure button.

Wait for a while until the measurement starts. It will take about 30 seconds settling time in the case 
of the 1 pA range. 

8. The Data display window opens.
Time zero means the first voltage output and then the measurement starts. 
The example graph shows the first measurement at 24.6 sec. which indicates the rough settling time 
of the 1 pA range of ASU.
Activate Marker by clicking the Marker button. Marker is activated.

9. List display highlights the first measurement point which indicates the Marker position.
The example shows 0.4 fA p-p variation in 16 PLC integration time.

Axis Name Sharing Scale Min Max
X Time (None) Linear 0 s 100 s
Y1 Id (None) Linear -10 fA 10 fA
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Id-Vg Sub-threshold Ultra-Low Current Measurement:
- Channel Definition setup

This lab measures ultra low current using the 1 pA range of ASU.
We use Id-Vg measurement with the 100 μV drain voltage. The 100 μV drain voltage is unusually 
small for typical Id-Vg measurement, but this assures lower drain current in the sub-threshold 
measurements.

To set up the Id-Vd measurement:
Follow the next steps by referring to the numbers shown in the slide.
1. Click Classic Test mode tabs
2. Click on Multi Channel I/V Sweep Classic test icon.
3. Multi Channel I/V Sweep – Channel Setup page opens.
4. Set the following channel setup.

5. Set Time Stamp Name to "Time".
6. Change Setup Name to "Id-Vg 100 uV"

Unit V Name I Name Mode Function
SMU1:HR Vs Is V CONST

SMU2:HR/AS Vd Id V CONST
SMU3:HR Vg Ig V VAR1
SMU4:MP Vsub Isub V CONST
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Id-Vg Sub-threshold Ultra-Low Current Measurement:
- Channel Definition setup
Follow the next steps by referring to the numbers shown in the slide.

1. Click on Measurement Setup page tabs.
2. Set the following parameters in the VAR1 Parameter input fields.

3. Set the following parameters to Constants field.

4. Click on the Range button. SMU Range Setup window opens.
5. Set the following parameter to SMU2:HR/ASU Range parameter:

- Range = 1 pA
- Range Change Rule: GO UP AHEAD,  Rate=50

6. Click on the ADC/Integ button. "A/D Converter & Integration Time Setup" window opens.
7. Set the following parameter to Integration Time field of "High Resolution ADC":

- Mode = PLC,  - Factor = 32,  - Auto Zero = OFF

Direction Linear/Log No of Step
Single Linear 41

Unit Name Start Stop Step Compliance Pwr Comp
SMU3:HR Vg -500 mV 1.5 V 35 mV 100 uA OFF

Unit  V Name I Name Mode Source Compliance
SMU1:HR Vs Is V 0 V 100 mA

SMU2:HR/AS Vd Id V 100 uV 100 mA
SMU4:MP Vsub Isub V 0 V 100 uA
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Id-Vg Sub-threshold Ultra-Low Current Measurement:
- Data Display setup

Follow the next steps by referring to the numbers shown in the slide.
1. Click on the Display Setup page tabs.

Display Setup page opens.
2. Set the following X-Y Graph parameters.

3. Set the following parameters for List Display items:
- Time
- Id
- Vd

4. Click Save the setup to My Favorite Setups.

Axis Name Sharing Scale Min Max
X Vg (None) Linear -500 mV 1.5 V
Y1 Id (None) Log 100 aA 10 uA
Y2 Id (None) Linear 0 A 10 uA

2-9-12



Id-Vg Sub-threshold Ultra-Low Current Measurement:
- Test device connection with N1295A Test Fixture

Connect the Demo device (4 terminal MOS FET) as shown in the slide.

To Set Device:
1. Form the device leads so as it can fit to the N1295A device socket..
2. Set the devise to the N1295A Test Fixture as shown in above slide.

- Source - #1 pin
- Drain - #2 pin
- Gate - #3 pin
- Sub - #4 pin
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Id-Vg Sub-threshold Ultra-Low Current Measurement

To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting the test.

This is especially important when the measurement covers a wide current range from sub-
pA to a mA range. 

2. Click Single Measure button.
Measurement starts.

3. The Id-Vg 100 uV data display window opens.
Note:
It takes about 30 seconds until the first measurement point shows up on the X-Y graph 
because the 1 pA range requires long wait time.

4. The measurement of sub-threshold region in this lab shows ultra low current as shown in 
the figure.
If you require sub-fA level measurement, the 1 pA range of ASU is the best choice.

Tips:
1. If your low current requirement is okay with over 1 fA resolution, then 10 pA range 

would be a better choice considering the faster measurement speed.
2. 10 pA range of the ASU is about two times lower noise than HRSMU. 
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Low Current Measurement Tips

There are many thing to manage to achieve the ultra low current measurement.
The following section provides some useful tips which can be used as a check list when you 
perform ultra low current measurements.
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Low current Measurement Tips for Noise on AC Power Line:
- Set correct Power Line Frequency
- Use PLC (Power Line Cycle) for Integration Time
- Use electrostatic shielding

Power line is a major noise source in low signal measurements.
It is connected to variety of electric equipment, and all the noise generated by them are 
spreading through the power line from low frequency to high frequency.

There are two most effective approaches to reduce power line related noise;
1. Set correct Power Line Frequency

You can set the power line frequency by using the Configuration window of the 
EasyEXPERT

2. Use PLC (Power Line Cycle) for Integration Time
The correct frequency power line averaging filters the power line frequency related noise 
drastically as shown in #1 illustration of the slide.

3. Use electrostatic shielding.
This is effective for not only the power line source related, but all the other noise source 
that is coupling through stray capacitance.
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Low Current Measurement Tips
- Use guarding to reduce the leakage current between your prober 
and the SMU

The active guard shown in the slide surrounds the signal line with an actively driven conductor 
which maintains the signal line and the surrounding conductor at the same voltage potential, and 
it eliminates the leakage currents from the signal line to the ground line. Good guarding can only 
be achieved using the triaxial connectors and cabling. In the triaxial cable, the signal line is 
surrounded by the guard line (separated by the insulating material), and the guard line is also 
surrounded by a grounded  line to shield from the outside noise.

When connecting triaxial cable to your coaxial probe, the only way that we can make a low-current 
(below one nanoamp) measurement with a BNC cable is to connect the driven guard to the outer 
shield of the BNC cable as the figure.
This configuration presents a couple of significant challenges:
1. The outer shield of the BNC must be isolated from ground.
2. The outer shield of the BNC can reach dangerous voltages (> 40 V), so precautions must be 
taken to ensure that the user is properly protected from receiving a fatal electrical shock.
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Low Current Measurement Tips
- Wait several minutes after connecting cables or moving probe needles

To connect the cable and start measurement:
1. Remove the test device from the test fixture, and close the lid.
2. Remove the triax cable from the test fixture #2 input as shown in the slide. The other end is 

connected to ASU.
Wait about 1 min.

3. Setup the I/V-t Sampling classic test with the following setup.
Change the I/V-t zero sampling setup in the following parameters.
- Range: SMU2 HS/AS => 100 pA limited auto range.
- Sampling interval : 100 ms.
- No. of samples: 501 (0 – 50 sec sampling periods.)
- A/D Converter Integration Time: HR ADC  PLC=1
- Display Setup: X Axis=0 ~ 50 sec, Y axis=-1 pA ~ 1 pA

4. Start the I/V-t Sampling classic test.
The I/V-t sampling measurement starts.

5. Re-connect the cable and rock the connector.
6. The noise shows up on the I/V-t Sampling.

About 10 pA current noise is seen in the example.
7. Y axis view of 10 times enlarged is shown.

After the transient of the cable reconnection, there appears about 50 fA and 50 sec long time 
disturbance until the signal returns to the initial current level.

Note:
The disturbance can be considered mostly by the temperature change by heat transferred from the 
hand when connecting the connector.

It is always recommended to wait at least 1 minute before starting low current measurement after making 
any change in the cabling.
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Low Current Measurement Tips
- Perform Self Calibration & Zero Cancel

The SMU can be thought of as a sophisticated OP AMP.  With any OP AMP there is an associated 
input offset error.  This error is small and varies with ambient temperature shifts and other factors.  
It can be reduced to a negligible amount with the Zero Cancel function.
Zeroing is performed with the probes up.  If there is a very large error to correct, you may get a 
warning message.  This usually means that SMU Self Calibration has not been recently performed. 
SMU calibration eliminates gross.  Zeroing only has an effect on the 1 nA range or less.
Use the Calibration window to perform the SMU calibration and zero cancel.  See the next page.

NOTE:
The B1500A provides the auto calibration function which automatically starts calibration for all 
modules every 30 minutes if the output switches of all modules are off for 30 minutes.  You can 
enable or disable this function on the Calibration window.  If auto-calibration is enabled, move 
probes up (open measurement terminals) after measurement to prevent from possible device 
damaging.
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Low Current Measurement Tips
- Shut the lid of test fixture or shield box to prevent effects of light

The light generates leakage current.
It is obvious in the case of on wafer measurement.
But, even in the packaged device, sometimes the light is coming inside the package through the 
glass seal of the device leads.

Always close the lid of the test chamber and turn off the light if it is inside the chamber.
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Low Current Measurement Tips
- Keep constant temperature in the room

Temperature fluctuation of the measurement cable induces 10's fA level offset current drift in a 
short term bases.
In the ultra low current measurements using ASU's lower range requires strict temperature control 
if a stable measurement under a few fA level stability.

The tips for stabilizing the local temperature in the measurement area are;
• Cover the measurement environment from the air conditioner for low current measurement 

under sub pA level.
• Stop the air conditioner for some periods to perform a quick measurement.
• Wait for Starting the measurement for a while until the temperature of the measurement 

environment stabilized when you change the hardware setup.
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Other Low Current Measurement Tips

These are other low current measurement tips.

See also:
Application Note B1500-15
Ultra Low Current DC MOSFET Characterization at the Wafer Level
http://cp.literature.keysight.com/litweb/pdf/5990-5547EN.pdf
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Lab 9: Summary

We learned the topics/items listed in above slide through measuring 
ID-VDS pulsed IV tracer Test.
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Lab 10: Pulsed IV Measurement Using 50 μs pulsed MCSMU

Lab 10 covers following topics.
1.What is MCSMU?
2.MCSMU Configuration with the N1255A 2 channel connection box for MCSMU
3.Lab device setup to N1295A Test Fixture
4.About the SD214DE  Pulsed IV (PIV) demo
5.Perform Id-Vd Pulsed IV test.
- Setup ID-VDS 1 ms pulsed IV Tracer test and measurement.
- Oscilloscope View setup and measurement.
- 100  μs pulsed measurement and the comparison with 1 ms pulsed measurement.
- Minimum pulse measurement.
6.Summary
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What is MCSMU?
Key Features of MCSMU:
- Range up to 30 V/1 A pulsed (0.1 A DC) with 4-quadrant operation
- Pulse measurement from 50 μs pulse width with 2 μs resolution
- Oscilloscope view (voltage/current waveform viewer) is supported

MCSMU have the following characteristics.
The major difference between the traditional SMU is shown in # 4, 5 and 6 below.
1. Fast sampling Im and Vm:

The Im and Vm is made by fast digitizer, and the measurement is typically made by using actually measured Vm and Im
value instead of the traditional Vf and If. 
The set voltage, Vf is output from the SMU.

2. Since the Vm and Im are made in real time in very fast sampling rate, the Vm and Im can be seen on Waveform 
Monitor.

3. Example of the waveform monitor of EasyEXPERT.
The Vm and Im monitoring capability eliminates the use of the traditional oscilloscope in the high power pulsed 
measurements.

4. Force & Sense output must be connected:
There is no built-in sense resistor between the force and sense output, and the sense cable must be connected always 
as shown in the slide.
The output impedance is seen zero ohm from the DUT.

5. Floating SMU:
The output of MCSMU is  floating from the circuit common. 
The current from the SMU High Force terminal returns to the Low Force terminal instead of the GNDU in the traditional 
SMUs.

6. The reference voltage:
The GNDU connection is still necessary as a reference potential of the measurement system.
Adding reference voltage by using SMU is also possible.

7. The VI characteristics is the same as traditional SMU:
Example measurement graph is shown.

You can use MCSMU as same as traditional SMU if you care about these advanced differences.
(Note: N1255A 2 Channel Connection Box as shown in next page is prepared to absolve these small differences.)
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MCSMU Output Configuration using N1255A
N1255A 2 Channel Connection Box is used to use MCSMU exactly the same as the traditional SMUs.

The slide shows the connection example using N1255A for 4-terminal MOSFET using the traditional 
four terminal triax connector/cable fixture/manipulator.
N1255A can convert the following MCSMU features to be compatible with the traditional SMU's output 
characteristics:
• Floating SMU:

Convert the floating SMU to Low grounded SMU using GNDU or SMU.
• Full Kelvin output:

Traditional SMU includes the high impedance sense resistor between the Force and Sense output, 
which provides the following two benefits:
1. You can make measurements without connecting sense triax cable
2. If you connect sense triax cable, it provides full Kelvin performance if the force resistance is 

less than 10 ohm.
Note:

1. MCSMU Kelvin capability allows you higher force line resistance and higher voltage 
difference between the force and the sense line than traditional SMU.

2. N1255A has Kelvin, Non-Kelvin selection switch for replacing internal sense resistor of 
traditional SMU.

N1255A provides following additional capability:
• Series or Shunt resistor for gate connection.

This resistor is useful for increasing the stability in higher current transient in narrow pulsed 
measurement.
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B1500A MCSMU connection with N1255A 2 channel Connection Box and N1295A 
Test Fixture:

Step 1. MCSMU connection to N1255A:
Connect the B1500A SMU outputs and the N1255A input terminal with the triax cables by 
following the steps shown in the slide.
1. Connect the SMU 2 Force output to the N1255A GNDU/SMU Force input.
2. Connect the SMU 2 Sense output to the N1255A GNDU/SMU Sense input.
3. Connect the MCSMU 1 Force output to the N1255A MCSMU 1 Force input.
4. Connect the MCSMU 1 Sense output to the N1255A MCSMU 1 Sense input.
5. Connect the MCSMU 2 Force output to the N1255A MCSMU 2 Force input.
6. Connect the MCSMU 2 Sense output to the N1255A MCSMU 2 Sense input.

Step 2. connection to N1295A Test Fixture:
7. Connect the N1255A High 1 Force to the N1295A Input 2.
8. Connect the N1255A High 2 Force to the N1295A Input 3.
9. Connect the N1255A High 1 Force to the N1295A Input 1.
10. Connect the B1500A SMU 1 Force output to the N1295A Input 4.

Step 3. N1255A switch configuration:
11. Set all the SMU sense setting to "Non-Kelvin" side.
12. Set Series Resistor to "0 Ω" side.
13. Set Shunt Resistor to "Open" side.
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Demo device:
Slide shows the 4 terminal Demo MOS FET.
The commercial name of the FET is SD214DE.

SD214DE basic characteristics:
- Nch MOS FET
- Max Vd : 20 V
- Max Vg : 30 V
- Max Id : 50 mA
- Vth : <1.5 V
- Typical Ig : <1 pA
- Max. Power : 300 mW @ 25 °C  Tjmax=125 °C

Device leads forming for N1295A Test Fixture:
There is basically no device lead forming  necessary.

Note:
While forming the leads, keep the shorting wire to protect the gate from any damage.
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Test device connection with N1295A Test Fixture:

Connect the Demo device (4 terminal MOS FET) as shown in the slide.

To Set Device:

1. Form the device leads so as it can fit to the N1295A device socket.

2. Set the devise to the N1295A Test Fixture as shown in above slide.
- Source - #1 pin
- Drain - #2 pin
- Gate - #3 pin
- Sub - #4 pin
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The Pulsed IV demo concept:
The maximum output power of MCSMU is 30 V, 1A (100 mA DC) in pulsed mode.
The test device used in the Lab is SD214DE small signal MOSFET.
The allowable maximum power is 300 mW continuous at 25 °C
case temperature.

There is no power specification for pulsed use condition, but lets consider that the device can be 
used higher power in pulsed measurement.
We uses the pulsed max. rating as shown in the slide for maximum 1 ms pulse width in the lab.
• Max Vd: 20 V
• Max Id: 100 mA
• Max Power (Pulse): 2 W
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Open Tracer Test mode & Set the SMU Channel Definition
1. Click Tracer Test tab.

Tracer Test mode screen shown in above slide opens.
2. Click "Sample setups" menu.

Sample setup menu pops up.
3. Select "MOSFET" category  opens MOSFET tracer test definition menu.
4. Click "ID-VDS" setup.

ID-VDS setup appears.
5. Re-assign the Drain and the Gate SMU to MCSMUs from the default SMUs:

- Replace  Drain SMU to SMU5:MC.
- Replace Gate SMU to SMU6:MC.
Note: The SMU number may differ from this example depending on your B1500A configuration. 
Assign the MCSMUs which you have configured on page 2-10-4.

6. We are adding "Source" and "Sub" SMUs.
Click "Add" opens available SMUs list for adding to the  source and measure unit list area.

7. Add available SMUs from the list by clicking the SMU list.
8. The SMU order can be changed by using UP/DOWN button.
9. Set the SMU names, mode and functions as follow.

Make sure to change VGS mode to "VPULSE".

Unit V name I Name Mode Function
SMU6 VGS IG VPULSE VAR2
SMU5 VDS ID VPULSE VAR1
SMU2 VS IS V CONST
SMU1 Vsub Isub V CONST
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Set SMU Output Parameters (VAR1, VAR2, CONST) and Display setup:
To set X-Y scale:
Set X axis:
1. Click on the maximum X scale value.

Note: The focus area to detect your touch is very narrow.
Click exactly on the character area to pop up the scale input box.

2. Horizontal Max. input box pops up.
- Enter  25 V, then click X mark of the input box or press Enter key.

Note: Clicking other area cancels your input.
- Horizontal max. scale is changed to 25 V.

Set Y axis:
3. Click on the maximum Y scale value.
4. Vertical Max. input box pops up.

- Enter  100 mA, then click X mark of the input box or press Enter key.
- Vertical max. scale is changed to 100 mA.

To Setup VAR1:
5.  Set VAR1 parameters:

a. Click the down arrow icon      .  
VAR1 field expands.

b. Set the following parameters:
Tips: To scroll the measurement parameter input field:

c. By focusing (pointing) the parameter input field, "Drag to scroll" sign appears (see #d).
e. By dragging the bar, the mouse cursor changed to "hand " mark, and you can scroll the bar, and 
can see hidden part of the bar.

Mode Start Stop NOS Interlacing Compliance Pwr comp V Comp
LIN-SGL 0 V 5 V 31 1 100 mA 2 W OFF

Pulse Base Pulse Delay Pulse Width Dual Polarity Hold Time
0 V 0 s 1 ms OFF 0 s
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To Setup VAR2:
6. Set VAR2 parameters

a. Click the down arrow icon       on VAR2 parameter field.
VAR2 field expands.

b. Drag the VAR2 field, and scroll the input field to an appropriate position.
c. Set the following parameters

To Setup CONST:
7. Set CONST parameters

d. Change the CONST field to set each SMU parameters by changing the SMU Unit field.
e. Set the following parameters to each SMUs. 

To Setup Measurement time parameters:
8. Set Meas. Delay, Time & Pulse Period

f. Set the following parameters.

To Save the setup:
9. Click the Setup Name field, and change name to "ID-VDS TT 1ms

10. Click to Save button to save the setup to My Favorite setups.

Start Stop NOS Compliance Pwr comp
0 V 5 V 5 100 mA OFF

Pulse Base Pulse Delay Pulse Width Hold Time
0 V 30 us 1 ms 0 s

Unit Source Compliance
SMU1 0 V 100 mA
SMU2 0 V 100 mA

Meas. Delay Meas. Time Pulse Period
AUTO 20 us AUTO
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ID-VD Sweep Measurement
 To Setup Demo MOSFET

Refer to the demo device setup section of Lab 1 module.

 To Start Measurement:
Follow the next steps to start measurement.
1. Close the test fixture cover before starting a test.
2. Click Repeat Measure button.

Repeat measurement starts.
3. The ID-VDS real time sweep trace appears as shown in above slide.

The Id-VDS curve in yellow lines sweep from VDS=0 ~ 5 V.
4. Highlight the VAR1 Stop entry field and leave it in active status.
5. Rotate the rotary knob, and increase the Stop voltage to 20 V.

Or you can directly type in the number using the keyboard.
6. The example measurement curve increases to 20 V as shown in blue lines.

Note that the blue line is shown as a reference. Actual line is shown in yellow.
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Let's increase the ID to about 100 mA

You can change any measurement parameters while the measurement is executed by selecting the 
parameter, and then rotating the knob or directly typing in the parameter from the keyboard.

To increase the VAR2 step value
1. Click Stop parameter in VAR2 input parameter field.
2. Increase the Stop voltage until the ID maximum current increases to, say around 90 mA is okay, by 

rotating the knob as shown in yellow ID-VDS curve in the slide.
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Monitor the pulse waveforms using Oscilloscope View

You can monitor the waveforms of the output voltage and the current on the specified measurement point.
In the pulsed measurement, it is very important to check the pulse waveform, pulse current and the relation of 
the measurement point in the pulsed signal to assure the measurement reliability.

To monitor the pulse waveform:
1. Click the Oscilloscope View icon.

Note: If you recall the setup from My Favorite example, then the following parameters are already set.
2. Oscilloscope view window opens.

You can change most of the parameters by clicking on the Oscilloscope view parameters.
3. Sampling parameter selection and the parameter setup can be made through the view menu. 
4. Marker field shows the time and the readout at the marker position.
5. The scales of each parameter are shown.
6. Oscilloscope View's monitoring point is indicated on the measurement curve.
7. The pulse waveforms for ID, VDS and VGS are shown.
8. Measurement time windows is shown.
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Set Oscilloscope View Parameters
To Setup Oscilloscope View parameters for ID-VDS measurement:

Follow the following steps by referring to the numbers shown in the slide.
1. Click Data menu.

Available measurement parameters for Oscilloscope view show up.
2. Click and select a parameter to view on the oscilloscope view. 
3. Marker view field:

The popup menu closes after the selection of a parameter and the selected parameter is added on the marker 
view field.
Repeat #2 and #3 steps for all the parameters to view on the Oscilloscope.
The parameters are added in the Marker view field.

4. Scale parameter view field:
Scale parameters of oscilloscope traces are shown in this area.

5. Click on the Marker view field. Sampling Setup window pops up.
Set the sampling duration of the oscilloscope view to 1.1 ms.
Since the pulse width is set as 1 ms, total pulse waveform can be monitored. 

6. Set the Time scale to 200 us/div. by clicking on the s/div field.
7. Set the Time origin (center value) to 400 us by clicking on the Time origin number so as you can view whole 

waveforms.
8. Each trace's scale parameter set window displays the vertical scale, the center reference point and the line 

color. These parameters  can be set by clicking on each parameters.
Set the following scale parameters.

Data /deiv. Offset Colour Type
VDS 5 V -10 V Default Default
ID 20 mA 20 mA Default Default

VGS 2 V -8 V Default Default
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Oscilloscope View Example
Oscilloscope View shows the waveforms of the specified VAR1 measurement points basically by toggling the 
VAR2 steps from the start value towards the stop value as shown #1 in the slide. 
The waveforms of each measurement points surrounded by the red circle of #1 are shown.
Note that the ID waveform increases as the VGS increases.

To set Oscilloscope View sampling points:
You can specify the sampling points of Oscilloscope View to monitor the pulse waveform.
Sampling Setup provides the following choice:
Open Sampling Setup. (refer to #2 in the slide)

• VAR1 Step: 
This parameter specifies the measurement steps of VAR1 to view the waveform.
• Specified sweep point number

or 
• LAST: LAST VAR1 step number specified by the setup.

Note: There is no refresh in waveform view if there is no measurement due to, for example, 
hitting the power compliance or current compliance.

• VAR2 Step: 
This parameter specifies the waveform measurement points of the VAR2 steps.
VAR2 steps can be set one of the following two choices;
• EACH: Measures all the VAR2 steps 

or
• Specified VAR2 step
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Let's change the pulse width to 100 μs and check the narrow pulse effect

This page tries the following two labs.
- Set 1ms pulsed ID-VDS curve as the reference trace.
- Change the pulse width to 100 μs.

To set the reference trace
1. Display 1 ms pulsed ID-VDS trace
2. Click the "Capture the reference trace" icon.

ID-VDS trace of 1 ms pulsed measurement is captured as a reference trace and displayed as blue lines.

To change the pulse width to 100 μs
3. Click the repeat measurement.
4. Change the VAR1 (Drain) pulse width to 100 us.
5. The trace changes as shown in yellow lines.
6. The Drain pulse width changes to 100 μs.

Comparison with the 1 ms pulsed ID-VDS results
7. The ID of 100 μs pulsed measurement increases compared to the ID of 1 ms pulse.

This is thought that the drain junction temperature decreases due to the narrower pulse width.
In this way, the measurement in narrower pulse shows closer to real operating characteristics if the device is used 
in a narrow pulse application.

8. Change the Oscilloscope view time parameters as;
- Time scale: 20 us
- Time origin: 50 us

9. Change VAR2 pulse width to 100 us
By narrowing both the drain and the gate pulse width, you can reduce the pulse period and increase the 
measurement speed.
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50 μs  Minimum Pulse Measurement Example
Let's try to measure with narrower pulse than 100 μs.
The oscilloscope view shows the value especially in the narrow pulsed measurement.

To narrower the pulse width to less than 100 μs
1. Change the power compliance (Pwr Comp.) to OFF.
2. Decrease the Pulse width between 60 us and 65 us.

While decreasing the VAR1 pulse width, monitor the pulse waveforms of VGS, ID and VDS and the delay between 
VGS and VDS.

3. If the ID curve shows somewhat abnormal as shown in the example, check the pulse waveforms. 
4. The example pulse waveforms at the last VAR1 steps of VAR2 step 5 are shown.

The green bar in the time scale shows the measurement time window.
The example waveform indicates the measurement starts before the ID (purple line) settled to its final value.

5. Change the Meas. Time to 2 us.
Now the Measurement time becomes narrow, and it measures ID after it settles to the final value.

6. Now, the ID curve shows the same as before it starts to distort.
7. Reduce the pulse width to 50 us.

Now it may show some decrease in ID.
This time, the VAR2 delay time is too large and ID cannot be settled in 20 μs period (= 50 μs pulse width – 30 μs 
gate delay).

8. Reduce the pulse delay to 20 us.
Now, ID shows the original curve, again. 
You have successfully made the 50 μs pulsed ID-VDS measurement with a good accuracy.

Note: If you reduce the VAR2 delay to less than about 10 us, then the ID starts to decrease again.
This is because the VDS rise up time becomes slower.
In this way, the gate delay is an important parameter in the pulsed IV measurement.
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Lab 10: Summary

We learned the topics/items listed in above slide through measuring ID-VDS pulsed IV tracer Test.
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Performing Windows Initial Setup 
 

1. Make sure that the Standby switch is set to off. 
2. On the B1500A rear panel, connect the Circuit Common terminal to the frame ground terminal by using 

a shorting-bar. 
3. If you use Keysight 16444A-001 USB keyboard and/or the 16444A-002 USB mouse, connect it to an 

USB port of the B1500A. 
4. Connect the power cable from the B1500A to an AC power outlet. 
5. Open the measurement terminals and press the Standby switch to turn on the B1500A. 

If the B1500A is operating correctly, the power-on self-test is automatically performed. If problems 
arise, see Keysight EasyEXPERT User’s Guide. 

6. Follow the Windows setup wizard and complete the initial setup. 
a. Set the system display language to English. The language must be English. If you set another 

language, you must perform the system recovery of the B1500A. See Keysight EasyEXPERT 
User’s Guide for the system recovery. 

b. Set Country or region, Time and currency, and Keyboard layout.  
If you use the 16444A-001 USB keyboard, the Keyboard layout must be US. 

c. Accept the End User License Agreement. 
d. Set Time zone, date and time. 

 
After the initial setup, the B1500A internal Windows has the following users available:  
- Administrator  
- Keysight B1500 User 
- KeysightOnly 
You can add users after the initial setup. Add users as you need. 
 
Keysight B1500 User is the account for automatic logon. Password is not set to this account. 
KeysightOnly is the account for Keysight service personnel. Do not delete this account. This account is 
password protected. 
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Managing Your Demo Data and Setup 
 

The EasyEXPERT of User Demonstration is performed under “Demo 
Workspace” using the demonstration device included in the User 
Demonstration Kit. 

 
Deleting your data when returning demo B1500A  

If you are using your device in the measurements, and you want to delete all 
the setup when you return the Demo B1500A, then you could manage the 
demo in the following way. 
 
1. Create your own workspace. 
2. Perform the entire demonstration under your workspace. 
3. Delete your workspace. 

You can perform this operation using the Workspace manager in the 
Workspace Configurator. 

 
This will safely delete all the measurement data and your library setup. 
 

A-3 
 



 

Description of the Test Library Used in the Demonstration 
 
The description of the Test Definition  
The following describes the Test Definition used in the User Demonstration. 
 

Note for Parameter Setting: 
The polarity of the measurement parameter is to be set for NMOS devices.  
For measuring the PMOS, set the Polarity to Pch in the Device Parameters. 

 

Id -Vd: 
Evaluation of Id-Vd Characteristics (4-terminal version) 
 
Application: 
This application is used to evaluate the characteristics of drain current 
versus drain voltage (Id-Vd) of a MOSFET. 
 
Description of Measurement: 
The drain voltage is swept as a primary sweep with the gate as a secondary 
step voltage sweep. 
The drain currents are measured. 
 
Plot Display: 
The drain current versus the drain voltage is displayed in linear scale. 
The plot display can be changed to show the drain current per unit gate 
width.  
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Vth gmMax: (4-terminal version) 
Evaluation of Vth in linear region  
 
Application: 
This application is used to evaluate the threshold voltage (Vth) from the 
Id-Vg characteristics.  Vth is extracted by using the extrapolation method 
from the linear region characteristics of a MOSFET.  
 
Description of Measurement: 
The gate voltage is set referenced to the source voltage (0 V). 
The gate voltage is swept and the drain current is measured.  
The following parameters, Vth and gmMax are shown. 
 
Plot Display: 
The drain current and transconductance (gm) are plotted versus gate 
voltage. 
 The drain current is displayed both in linear (Y1) and log scale (Y3). 
 The transconductance is displayed in linear scale (Y2). 
 The horizontal axis (X) is the gate voltage in linear scale. 
 
The threshold voltage is extracted by the following procedure. 
(1) A tangent line is drawn at the point where transconductance reaches the 
maximum value on the characteristics of drain current.  
(2) A voltage value is obtained at the point where the tangent line intersects 
the gate voltage axis.  
(3) The threshold value is extracted by subtracting vd/2 from the voltage 
value.  

 
 
 

I/V Sweep. Id-Vg Vth Demo: 
The classic test using the I/V Sweep performs Id-Vg measurements. 
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Looking up Application Test Library 
The contents of the EasyEXPERT application test library are opened to the EasyEXPERT user. 
The test definition of the library can be opened and easily understood just by looking inside the definition. 
 
Walking through the simple test definition (Hands on) 
The input parameter of the Application Test Library is set to both the minimum and maximum limit 
according to the target application.  You might want to input a value exceeding the limit or to reuse the 
existing test definition with another technology device characterization. 
In that case, you might want to change the existing test definition. 
 
Let’s see and change the Simple Vth test definition to understand how the Library is created. 
The following three steps are explored. 

1. Open the Simple Vth test definition. 
2. Change the limit of the input parameters. 
3. See where the measurement is executed. 

 
Step 1. Open the Simple Vth test definition. 

- Right-click the Simple Vth test definition in the CMOS Test category. 
- Select Open Definition of This Test … 
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Step 2. Change the limit of the input parameters. 
The Test Specification window opens. 

 
This window is for setting the Test definition GUI design; you can  
set the items shown. 
 
For example, if you want to change the allowable range of the  
input parameter, it can be easily done by the following step.  

1. Click the Description field of “Vd” Name of the Test Parameter Definition 
(shown as )  
”Vd” appears as a drain parameter in the Simple Vth setup page shown in 
the previous page. 

2. Properties of the “Vd” input parameter appear in area. 
The following parameters can be set or changed: 
- Allowable minimum input value 
- Allowable maximum input value 
- Number of digits that can be set in the input field 
- Acceptable minimum resolution of the input value 
- Unit of the input 
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3. The typical value that can be chosen from the pre-defined list can be set 
by . 

4. Change the Test name to a different name (shown by ), and File  
Save will add a new Test Specification to the CMOS Category. 

 

Step 3. See where the measurement is executed. 
The measurement components are set in the “Test Contents” tab. 
Simple Vth is the simplest test definition, and used for training purposes. 

 
 

Let’s see the measurement engine of the test contents. 
1. Move the mouse to the Simple Vth line  and click. 
2. The Classic Test: I/V Sweep editor appears . 

In the Channel Setup tab: 
The SMU assignment parameter is passed by the Resource name ( ) 
used in the GUI. 
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3. Click the Measurement Setup tab.  
The measurement parameters that are defined in the GUI parameter are 
passed using the same Name. 
 
For example, the sweep start value is passed using “VgStart” . 
 

4. The measurement parameter is not necessarily the variable passed from 
the GUI. 
If the parameter is not changed, you can input the real number as shown 
in . 
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5. Click the Display Setup tab . 
This tab sets up the data display. 
 
You can use the GUI parameter to set the min and max scale   
or just use a real number . 
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Desktop EasyEXPERT 
 
You can install Desktop EasyEXPERT software on your Windows PC.  
Desktop EasyEXPERT holds exactly the same capability of the B1500A`s EasyEXPERT, and it expands your 
B1500A demonstration in the following aspects; 

1. You can keep all the measurement results made on demo B1500A, and recall the test 
results after you return the demo B1500A or even in offline. 

2. You can check EasyEXPERT functionality in offline. 
3. You can use a larger Windows area of your PC when analyzing your data with the PC 

software. 
4. If you want, you can control B1500A from your PC as the same way as the native B1500A`s 

EasyEXPERT. 
 
 To Install Desktop EasyEXPERT Software 

Follow the instruction of the Desktop EasyEXPERT installation. 
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 To Start Desktop EasyEXPERT (Offline Mode) 
1. Click the "Desktop EasyEXPERT" icon on your Windows desktop. 

 
2. Start EasyEXPERT window opens 

 
3. Before starting Desktop EasyEXPERT, we set Desktop EasyEXPERT options as shown next. 

              
Step 1. Click "Option". 
Step 2. Click "Execution Mode..." 
      Execution Mode window opens. 
      Desktop EasyEXPERT has following two operation mode;  
      - Online mode: Such as B1500A and 4155/56 A/B can be controlled via GPIB. 
      - Offline mode: Creating application library and data analysis can be made. 
Step 3. We`ll select offline mode. 
      Check "Offline". 
Step 4. Select measurement model: Click "B1500A" 
Step 5. Click "OK", and close the Execution Mode window. 
 

4. Click Start EasyEXPERT button. 

 
Offline mode Desktop EasyEXPERT opens. 

 

1. 

3. 

4. 
5. 

2. 
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Returning the Demo B1500A 
When returning the Demo B1500A, please make sure all the items are packed as delivered to you. 
 
In addition, please be sure to delete any confidential data stored in the EasyEXPERT or Windows file 
system. 
 
 
Note: 

Keysight technologies will not delete any of the data when renting the 
demonstration B1500A to the next user. 
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